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Document Disclaimer
The information in this document has been carefully checked and is believed to be 
reliable. However, no responsibility can be assumed for inaccuracies that may not have 
been detected. LeCroy reserves the right to revise the information in this document 
without notice or penalty.

Changes or Modifications
Any change or modification not expressly approved by LeCroy voids the user’s authority 
to operate this equipment.

Trademarks and Servicemarks
CATC, USBAdvisor, USBTracer, USBTrainer, USBMobile, USBMobileHS, and 
BusEngine are trademarks of LeCroy. 

Microsoft and Windows are registered trademarks and Windows Vista is a trademark of 
Microsoft Inc.

All other trademarks are property of their respective companies.

Copyright
Copyright © 2007, LeCroy Corporation. All Rights Reserved. This document may be 
printed and reproduced without additional permission, but all copies should contain this 
copyright notice.

FCC Conformance Statement
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user is required 
to correct the interference at his own expense. The end user of this product should be 
aware that any changes or modifications made to this equipment without the approval of 
LeCroy could result in the product not meeting the Class A limits, in which case the FCC 
could void the user's authority to operate the equipment.

EU Conformance Statement
This equipment complies with the EMC Directive 89/336/EEC and the Low Voltage 
Directive 73/23/EEC, and their associated amendments for Class A Information 
Technology Equipment. It has been tested and found to comply with EN55022:1998 
Class A (EN61000-3-2:1998, EN61000-3-3:1995) and EN55024:1998 
(EN61000-4-2:1998, EN61000-4-3:1996, EN61000-4-4:1996, EN61000-4-5:1996, 
EN61000-4-6:1997, EN61000-4-11:1998), and EN60950:1999. In a domestic 
environment this product may cause radio interference in which case the user may be 
required to take adequate measures.
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WEEE Program

 

This electronic product is subject to  
disposal and recycling regulations that  
vary by country and region. Many  
countries prohibit the disposal of  
waste electronic equipment in  
standard waste receptacles. 
For more information about proper  
disposal and recycling of your LeCroy  
product, please visit  
www.lecroy.com/recycle. 
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Chapter 1:  Overview
The LeCroy Advisor™ USB 2.0 Bus & Protocol Analyzer is another in LeCroy's broad 
portfolio of analysis tools. As a fourth generation product, it builds upon LeCroy's 
experience and knowledge of the needs of the USB development and test communities. 
The Advisor interfaces with standard USB cables and connections to capture and display 
Hi-Speed and Classic-Speeds USB 2.0 bus traffic. 

1.1 Features
General
• Fully compliant with USB 2.0 specification
• Flexible design - reconfigurable hardware for future enhancements
• Supports all USB speeds (High-Speed, Full-Speed, and Low-Speed)
• User friendly CATC Trace Interface that displays bus traffic using color and graphics
• Trace Viewer available as free non-recording, view-only software
• Power-on self-diagnostics
• Three year warranty and hot-line customer support
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Physical Components
• High impedance tap inserts non-intrusively in any branch of a USB system 
• 128 MB of physical data recording memory
• Two recording channels - one for High-Speed traffic and one for Classic-Speeds 

traffic (either Low- or Full-Speed)
• Secondary recording channel aids in the development of multiple speed functions 

up-stream and down-stream of a speed-matching hub or transaction translator
• Convenient "Detach Device" switch operates with the Classic recording channel to 

save time and reduce USB cable/connector wear for multiple connects and discon-
nects to host 

• Full-speed USB connection to desktop or portable host PC 
• Internal wide-range AC power supply
• Break-out board (included)

Recording Options
• Triggering of new USB2.0 PIDS and split transaction special tokens (i.e. ERR, 

SPLIT, PING, NYET, DATA2, MDATA)
• CATC Trace displays and enumerates new USB2.0 Micro Frames
• Three forms of triggering: Snapshot, Manual and Event
• Automatically detects and captures high-, full-, and low-speed traffic
• Adjustable buffer size from 0.1MB to 128MB
• Versatile triggering-bit-wise value and mask data patterns up to sixteen bytes wide 

for Setup transactions and data packets
• Triggering on multiple error conditions - PID bad, bit stuffing bad, CRC bad, 

end-of-packet bad, babble, loss of activity, frame length violation, time-out or 
turn-around violation, data toggle violation

• A new transaction sequencer allows triggering or filtering on a token qualified by a 
data pattern and/or specific handshake, or alternately transactions can be filtered

• Advanced triggering with event counting and sequencing 
• Dedicated trigger for recording input and output that is used to interface to external 

test equipment
• Real-time traffic capture filtering and data packet truncation variable up to 245 bytes 
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Display Options
• Utilizes USB industry de facto standard CATC Trace graphical display of bus pack-

ets, transactions, split transactions and transfers
• Trace Viewer is backward compatible with Chief™, Inspector™, and Detective™ 

trace files
• User-friendly trigger position indicated by different colors of pre- and post-trigger 

packet color
• Markers can be set to assist with navigation and time calculations. Each marker can 

contain unique comments.
• Hide start-of-frame (SOF) packets as well as hide any packet or transaction
• Search for a specific PID
• Change bit order for all fields except Data Length, Time, and  

Packet #: MSB>LSB or LSB>MSB
• Detects and alerts the user to every potential bus error, protocol violation, and com-

binations thereof
• High resolution, accurate time stamping of bus packets, timing measurement, and 

analysis functions
• Extensive search and packet hiding capabilities 
• Comprehensive device class decoding plus user defined protocol decoding

Note:  Refer to Readme.txt on your installation CD for the latest information on 
features. 
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1.2 Graphical Bus Traffic Display
The Advisor USB 2.0 Analyzer transaction displays use color and graphics to present the 
captured transactions in an immediate, understandable and useful format.

Packets are shown on separate rows, with their individual fields both labeled and 
color-coded. Packets are also numbered (sequentially, as recorded), time-stamped. 
Protocol errors are automatically detected and highlighted in red.

The display is customizable, allowing the user to control the color scheme and the 
formatting of field contents. A hide feature allows users to enable the suppression of SOF 
packets and user defined packets or fields that may be uninteresting in a given context. 
Display formats can be named and saved for later use. Pop-up tooltips annotate packet 
fields with even more detailed information about their contents. 

The display software operates independently of the hardware, allowing it to function as a 
stand-alone Trace Viewer that is freely distributed. 
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1.3 Accurate Time Management
The Advisor USB2.0 Analyzer uses internal counter/timer circuitry to enable a reliable, 
accurate (16.67 ns resolution) time stamping of recorded bus traffic. This timing 
information is available both as a component of the graphical data display and as a 
contribution to a variety of measurement and analysis functions. Any number of markers 
can be added by the user to denote specific packets, and further timing measurements 
can be made from one marker to another or from marker to trigger. All time fields are 
presented as a time stamp, idle time, bit time or in a new time delta in either decimal or 
hexadecimal format.

An essential feature of time management is that idle traffic does not consume the 
Analyzer memory. Because of this unique technology, accurate timing calculations can 
be made while still preserving valuable recording memory for important bus traffic.

1.4 Comprehensive Error Detection and Analysis
The Advisor USB2.0 Analyzer detects and alerts the user to every potential bus error, 
protocol violation and/or combination thereof. The Analyzer contains circuitry in the 
BusEngine™ to perform real-time triggering on multiple error conditions, such as PID 
bad, bit stuffing bad, header or data CRC bad, end-of-packet bad, babble, loss of activity, 
frame length violation, time-out or turn-around violation and data toggle violation. The 
Analyzer program highlights all the hardware detected errors and further examines the 
trace file for additional protocol errors, including wrong packet length, data payload 
violation, and packet termination not on a byte boundary.

1.5 Real-Time Event Triggering and Capture Filtering
No attribute of a bus and protocol Analyzer is more important than its capacity for 
extracting useful information from a crowded stream of bus traffic. The ability to 
accurately identify, and selectively record, transactions of interest is the trait most 
valuable to the user. The Advisor USB 2.0 Analyzer offers a unique approach to this 
challenge. By using a set of recording resources, more than a dozen configurable 
hardware building blocks can be optimized to perform a particular activity appropriate to 
the task. A recording resource can independently await an initialization signal, monitor its 
external environment (external signals, other resources) in search of a particular event 
and take a subsequent action (triggering, inclusive or exclusive filtering, counting, etc.). 
Under control of the user interface, these resources can be selected, configured and 
combined to both search for complex trigger conditions and selectively capture the 
associated transactions.

Thus, as well as triggering on basic events, such as specific bus conditions and packet 
identifiers (PID) (see the Specifications section for a complete list), the Advisor USB2.0 
Analyzer can easily manage the most challenging requirements. For example: "trigger on 
the fifth occurrence of a SETUP Token device number nine", or "trigger on a SET 
INTERFACE request, following a specified eight-byte bulk data pattern match from this 
scanner, and do not capture any start-of-frame (SOF) packets."

The user can also configure the size of the recording memory, specify the pre/post-trigger 
capture ratio, and truncate the capture of large data packets up to the first 256 bytes.
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1.6 Advanced Event Counting and Sequencing
The count and sequence options define the rules for data recording sessions. These 
options provide the ability to configure and control the order of events that have been 
selected to trigger the USB2.0 Advisor Analyzer or filter the recording. There are two 
counters and a restart option that causes the sequencing to start again.

By utilizing this feature a designer can specify a specific sequence of events that must 
occur before the Analyzer triggers and finishes capturing data. This is extremely 
important in allowing a designer to pinpoint certain types of events for recording. Without 
this feature a designers must scroll through potentially megabytes of recorded data to 
locate a specific sequence or occurrence of a sequence that can take hours to locate 
before being able to begin analyzing the data of interest. 

1.7 BusEngine Technology
LeCroy's BusEngine™ Technology is at the heart of the new Advisor USB 2.0 Analyzer. 
The revolutionary BusEngine core uses state-of-the-art Electrically Programmable Logic 
Device (EPLD) technology and incorporates both the real-time recording engine and the 
configurable building blocks that implement data/state/error detection, triggering, capture 
filtering, external signal monitoring and event counting & sequencing. And like the 
flash-memory-based firmware that controls its operation, all BusEngine logic is fully field 
upgradeable, using configuration files.
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Chapter 2:  General Description
2.1 General Description

The LeCroy USB Advisor™ USB2.0 Protocol Analyzer is a stand-alone unit that is 
designed to be controlled and configured by a portable or desktop PC connected via its 
USB port. 

The Advisor uses hardware triggering to capture real-time events and hardware filtering 
to preserve memory and assist in pinpointing data of interest. Recorded data is then 
uploaded to the attached PC and displayed on the CATC Trace graphical user interface 
as color-coded packets that can be searched for specific data, errors or other desired 
conditions. 

The Advisor USB2.0 Bus & Protocol Analyzer is the ideal USB tool used in conjunction 
with any Microsoft® Windows® 2000, Windows XP, Windows Vista™ 32, or 
Windows Vista 64 desktop or portable PC in a USB development lab environment. 
Note: Support for Windows 2000 will end on January 1, 2008.

The Advisor Analyzer supports the Universal Serial Bus, version 2.0. 

Please refer to the Universal Serial Bus Specification, version 2.0 for details on the 
protocol. The USB specification is available from the USB Implementers Forum (USB-IF) 
at: 

USB Implementers Forum 
1730 SW Skyline Blvd. Suite 203 
Portland, OR 97221

Tel: +1/503.296.9892 
Fax: +1/503.297.1090 
Web: http://www.usb.org/
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2.2 Analyzer PC Requirements
The following is a list of recommended configuration for the host machine that runs the 
Advisor application and that is connected to the Advisor Analyzer: 

• Microsoft Windows 2000, Windows XP, Windows Vista 32, or Windows Vista 64 
operating system. Note: Support for Windows 2000 will end on January 1, 2008. 
The Advisor application can be used on machines with Windows to view trace files.  
Microsoft Internet Explorer, version 5 or newer.

• For optimum performance, use processors of the Intel Pentium III/Pentium 4 family 
or AMD Athlon/Duron family, or other compatible processors with clock speed of 
500 mHz or higher. (A processor of the Intel Pentium II/Celeron family or 
AMD K6 family with clock speed of 300mHz is required.)

• For the best performance, it is recommended to have physical RAM twice the size of 
the recording buffer setup - 256 MB or more. (Minimum is 128 MB of RAM.)

• At least 20 MB of free hard disk space is required for the installation. Additional disk 
space is needed for storing the recorded data in files during the recordings process 
(can be as much as 150MB when recording a full buffer size).

• Display: Resolution of 1024 x 768 with at least 16-bit color is recommended (resolu-
tion of 800 × 600 with 16-bit color is a minimum).

• A USB interface is required to connect to the Advisor Analyzer. This is not a require-
ment if the application is going to be used only as a viewer.

2.3 System Components/Packing List
The LeCroy Advisor Analyzer package includes the following items: 

• One stand-alone LeCroy USB Advisor™ Analyzer module
• One AC power cord with a plug appropriate to your location
• One External Interface Breakout Board with a 9-pin cable
• Five USB cables: four 3-foot (1-meter) cables and one 6-foot (2-meter) cable
• LeCroy Advisor software program installation CD
• Product documentation, including online help
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2.4 Stand-Alone Unit
 

Figure 2.1 Front Panel

 

Figure 2.2 Rear Panel

The Advisor Analyzer has several user-accessible controls on its front and rear panels.

• Red PWR (power) indicator LED: Illuminates when the unit power is switched on.
• Green REC (recording) LED: Illuminates when the unit is recording.
• Yellow TRG (triggered) LED: Illuminates when the unit triggers an event. Also 

lights during power-on testing and blinks when the hardware is faulty.
• Green UPLD (upload) LED: Illuminates when unit is uploading data to host PC.
• Manual Trigger push-button (allows a manual Trace capture)

• After beginning a recording session, press the Manual Trigger switch to force 
a Trigger condition. The session completes when a specified post-Trigger 
amount of bus data is recorded or when you manually stop a recording 
session.

• Detach Device push-button (allows a momentary disconnection of the device 
from the host on the Classic Speeds port). This is especially useful when the 
traffic of interest occurs during device enumeration. Use the Detach Device 
switch shortly after starting recording to capture a Trace of the device’s 
enumeration.

• Two USB ports, High Speed and Classic Speed, each with a type A and a type B 
connector.

• High Speed: Used to record 480 MB/s High-Speed traffic only
• Classic Speeds: Used to record either 12 MB/s or 1.5 MB/s Classic-Speed 

traffic
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• Wide range AC connector module: 
• Power socket
• Power on/off switch
• Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

Warning!  For continued protection against fire, replace fuse only with the type and 
rating specified above.

• USB type B host computer connector
• Data In/Out DB-9 (9-pin) external interface connector

Warning!  Do not open the Advisor Analyzer enclosure. There are no operator 
serviceable parts inside. Refer servicing to LeCroy.
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2.5 Specifications
Package 

Power Requirements
90 to 254 VAC, 47 to 63 Hz (universal input), 100 W maximum

Environmental Conditions 

Switches 

LEDs 

Recording Memory Size
128 Megabyte DRAM for traffic data capture, timing, state and other data

Dimensions 9.2 x 8.4 x 2.5 inches 
(23.4 x 21.3 x 6.4 cm)

Connectors AC power connection 
Trigger IN/OUT input (BNC) 
Host connection (USB, type B) 
Data connector (Data In/Out, 9-pin DB)

Weight 2.8 lbs. (1.2 kg)

Operating Temperature 0 to 55°C (32 to 131°F)

Storage Range -20 to 80°C (-4 to 176°F)

Operating Humidity 10 to 90%, non-condensing

Operating Altitude Up to 6560 feet (2000 meters)

Power on/off

Manual Trigger Forces trigger event.

Detach Device Detaches the device from the classic speed connection.

Power (PWR) Illuminated when the Analyzer is powered on

Recording (REC) Illuminated when the Analyzer is actively recording traffic data

Triggered (TRG) Illuminated during power-on testing and when the Analyzer has 
detected a valid trigger condition

Uploading (UPLD) Illuminated when the Analyzer is uploading its recording memory 
to the host PC for display
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Host Compatibility
The instrument works with any PC equipped with a functioning USB port and running a 
Microsoft Windows 2000, Windows XP, Windows Vista 32, or Windows Vista 64 
operating system. Note: Support for Windows 2000 will end on January 1, 2008.

2.6 External Interface Breakout Board
The External Interface Breakout Board is an accessory that allows convenient access to 
several potentially useful standard, fast TTL output and input signals. It also offers a 
simple way to connect logic Analyzers or other tools to the Advisor Analyzer unit. Four 
ground pins and one 5-volt pin are provided. 

Figure 2.3 External Interface Breakout Board

The Breakout Board connects via a cable to the Data In/Out connector located on the 
rear of the Analyzer box. Each signaling pin is isolated by a 100Ω series resistor and a 
buffer inside the Analyzer box.

Figure 2.4 Data In/Out Connector (on cable)
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Pin-Outs for the Data In/Out Connector
Table  lists the pin-out and signal descriptions for the Data In/Out connector on a cable 
that connects to the Breakout Board. 

Data In/Out Connector – Pin-Out

Note:  (*) Pins 2 and 3 have the same function: they allow external signals to be 
used to cause triggering or recording. Pins 4 and 5 are used to transmit 
output signals.

Prototype Rework Area
The Breakout Board contains a prototype rework area for making custom circuits for rapid 
development. The area consists of plated-through holes, 20 columns wide by 27 rows 
long. The top row of holes is connected to GND and the bottom row is connected to +5V. 
The remaining holes are not connected. Use the rework area to insert custom 
components and wire-wrap their respective signal, power, and ground pins. 

PC Connection
Use the LONGEST (6-foot/2-meter) of the five USB cables provided to connect the host 
computer to the Advisor Analyzer box.

Pin Signal Name Signal Description
1 +5V +5 Volts, 250mA DC source
2 TRG IN (*) Trigger Input
3 GP IN (*) General Purpose Input
4 TRG OUT (*) Trigger Output
5 GP OUT (*) General Purpose Output
6 GND Ground
7 GND Ground
8 GND Ground
9 GND Ground
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Chapter 3:  Quick Installation
The LeCroy USB2.0 Advisor™ Bus & Protocol Analyzer components and software are 
easily installed and quickly ready to run on most personal computer systems. You can 
begin making USB recordings after following these initial steps. However, if you are new 
to personal computers and protocol Analyzers, if you are unsure about what to do after 
reading the Quick Installation instructions, or if your Analyzer does not work after you 
follow these instructions, read through the subsequent sections in this manual.

Step 1 Connect the AC power cable to the rear of the Analyzer.

Step 2 Connect the USB port on the back of the Analyzer to the PC for analysis by using 
the LONG (6-foot/2-meter) USB cable.

Step 3 Insert the CD-ROM.

Step 4 Turn on the Power switch located on the rear of the Analyzer.

Step 5 Click NEXT when you see the Add New Hardware Wizard window.

Step 6 Follow the on-screen Plug and Play instructions.

Step 7 Click Finish when you see the message that says "Windows has finished 
installing the software that your new hardware requires" and the file Advisor.inf 
has been installed on your host PC. 

Step 8 Click Install Software and follow the on-screen instructions.

Step 9 Launch the LeCroy Advisor program from the LeCroy programs group.

Step 10From the Help menu, select About Advisor to display the version information.

If the information below is present, you can record a trace:

• Advisor Software Version
• Advisor Firmware Version
• BusEngine™ Version
• Unit Serial Number
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The following window opens: 

3.1 Your First USB Recording
After installing and launching the software, you can test Advisor by performing the 
following steps. 

Step 1 Connect a USB cable to each of the two connectors on the Advisor module, then 
connect the other ends to the USB device under test and USB host system.

Step 2 Select Recording Options under Setup on the Menu Bar.



USBAdvisor User Manual Chapter 3: Quick Installation

LeCroy Corporation  17

Step 3 Select the General tab to open the General page of the Recording Options dialog 
box, showing factory default settings such as Snapshot and 1 MB buffer size. For 
the first recording, leave these settings unchanged. 

Step 4 Click OK to activate the recording options you selected.

Step 5 Turn on the USB devices that are to be tested and cause them to generate USB 
traffic.

Step 6 Click  on the Tool Bar.

Advisor starts to record the USB traffic immediately. After 1 MB of traffic is 
recorded, the Analyzer uploads the data and displays the packets in the trace 
window.

Step 7 If you wish to terminate the recording before the snapshot  
 
 automatically completes, click  on the Tool Bar.

When the recording session is finished, the traffic is uploaded from the Analyzer 
to the hard drive on your PC as a file named data.usb or whatever name you 
assigned as the default filename. While the file is being uploaded, you should see 
a brown progress bar at the bottom of the screen. When the bar disappears, it 
indicates that the data has been uploaded to disk.
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Step 8 To save a current recording for future reference, select Save As under File on 
the Menu Bar.

OR

Click  on the Toolbar.

You see the standard Save As screen.

Step 9 Give the recording a unique name and save it to the appropriate directory.

Capturing Your First CATC Trace
After a moment, the recording terminates and the results display. 
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Trace View Features
• The Advisor packet view display makes extensive use of color and graphics to fully 

document the captured traffic.
• Packets are shown on separate rows, with their individual fields both labeled and 

color coded. 
• Packets are numbered (sequentially, as recorded), time-stamped (with a resolution 

of 16.67 ns), and highlighted to show the transmitted speed (low-speed, full-speed 
or high-speed).

• Display formats can be named and saved for later use. 
• Pop-up Tool Tips annotate packet fields with detailed information about their con-

tents
• Data fields can be collapsed to occupy minimal space in the display (which can in 

turn be zoomed in and out to optimize screen utilization). 

The display software can operate independent of the hardware and so can function as a 
stand-alone Trace Viewer that may be freely distributed. 
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Chapter 4:  Detailed Installation
4.1 Advisor System Setup

The Advisor™ Analyzer functions with any personal computer using the Microsoft® 
Windows® 2000, Windows XP, Windows Vista™ 32, or Windows Vista 64 operating 
system and equipped with a functional USB interface. Note: Support for Windows 2000 
will end on January 1, 2008.

The Analyzer is a stand-alone unit configured and controlled through a personal 
computer USB port. It can be used with portable computers for field service and 
maintenance as well as with desktop units in a development environment. It is easily 
installed by connecting a cable between the computer’s USB port and the Analyzer’s 
USB port.

Figure 4.1 USB Advisor Connection

The Advisor Analyzer provides on-the-fly detection of and triggering on such events as 
specific user-defined bus conditions, packets matching any Packet Identifier (PID), 
packets matching a Token or Setup transaction, data patterns, and errors and bus 



Chapter 4: Detailed Installation USBAdvisor User Manual

22 LeCroy Corporation

conditions. Whether recording manually or with a specified Trigger condition, the Advisor 
Analyzer continuously records the bus data in a wrap-around fashion until manually 
stopped or until the Trigger Event is detected and a specified post-Trigger amount of bus 
data is recorded.

Upon detection of a triggering event, the Analyzer continues to record data up to a point 
specified by the user. Real-time detection of events can be individually enabled or 
disabled to allow triggering on events as they happen. This includes predefined exception 
or error conditions and a user-defined set of Trigger events. The unit can also be 
triggered by an externally supplied signal. An external DB-9 connector provides a path 
for externally supplied data or timing information to be recorded along with bus traffic.

Real-time event detection information is available via an external DB-9 connector.

The Advisor software provides powerful search functions that enable investigation of 
particular bus events and allow the software to identify and highlight specific events. In 
addition to immediate analysis, you can print any part of the data. Use the Save As 
feature to save the data on disk for later viewing. The program also provides a variety of 
timing information and data analysis reports.

The Advisor Analyzer is designed to work with either desktop or laptop computers 
equipped with a functional USB interface.

To set up the system hardware, follow these steps:

Step 1 Connect the Analyzer to an AC power source.

Step 2 Connect the External Interface Breakout Board to the Data In/Out connector 
(optional).

Step 3 Connect to the personal computer via USB.

Step 4 Connect the USB host and the device being analyzed to either the High-Speed 
or Classic-Speed USB port.
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4.2 USB Test Ports
The USB Bus uses keyed connectors so that the type A connector joins a cable directed 
to downstream devices or to a hub and the type B connector joins a cable directed to an 
upstream host controller or to a hub. A USB hub is used to join multiple devices to an 
upstream host controller and therefore has both type A and type B connectors.

These ports have both type A and type B connectors so the Analyzer can conveniently 
tap a USB branch. To connect your USB branch for analysis, use the SHORT 
(3-foot/1-meter) USB cables to insert the Analyzer in place of the existing cables. 
Connect one cable to the type A connector and join it downstream to your device or hub. 
Connect the other cable to the type B connector and join it upstream to your host or hub.

Note:  The Advisor Bus & Protocol Analyzer is not a hub device; it connects to a 
USB branch by inserting a non-intrusive, high impedance tap. Because of 
the poor signal quality in the middle of a USB cable, LeCroy recommends 
using the shortest possible cables so that the total length of both cables 
together is less than 6 feet. The USB cables provided with your Analyzer 
meet this requirement. When longer cables are used, the Analyzer may 
record incorrect data.

4.3 AC Power Source
To turn on the system: 

Step 1 Connect the Analyzer box to a 100-volt to 240-volt, 50 Hz to 60 Hz, 120 W power 
outlet using the provided power cord.

Note:  The Analyzer is capable of supporting supply voltages between 100-volt and 
240-volt, 50 Hz or 60 Hz, thus supporting all known supply voltages around 
the world.

Step 2 Use the power switch located on the rear panel to turn the Analyzer unit on and 
off.

Note:  At power-on, the Analyzer initializes itself in approximately 25 seconds and 
performs an exhaustive self-diagnostic that lasts about 45 seconds. The 
Status LED illuminates during the power-on testing and turns off when 
testing is finished. If the diagnostics fail, the Status LED blinks, indicating a 
hardware failure. If this occurs, call LeCroy Customer Support for assistance.

USB Device USB Host
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4.4 Advisor Program Installation
The LeCroy Advisor software is provided on CD-ROM and requires a 
Microsoft Windows 2000, Windows XP, Windows Vista 32, or Windows Vista 64 
operating system. Note: Support for Windows 2000 will end on January 1, 2008.

Loading the Advisor USB Drivers
Step 1 Insert the Advisor CD-ROM into your computer.

Step 2 Power-on the Advisor Analyzer.

Step 3 Connect the USB cable to the rear of the Analyzer and to the personal computer. 

The host operating system detects the Analyzer and begins to install the USB 
driver.

Step 4 When Windows prompts you for a file, browse to the CD-ROM.

Installing the Advisor Application Program
To install the Advisor program, follow these steps:

Step 1 Insert the Advisor CD-ROM into your computer.

Step 2 Click Install Software.

Step 3 Follow the installation instructions on your screen. 

The Install Wizard automatically installs the necessary files to the computer’s hard drive. 
Advisor software is installed in the C:\Program Files\LeCroy\Advisor directory unless 
you specify otherwise. Follow the installation instructions on your screen.
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4.5 Advisor Program Startup
You can start the Advisor program from the Desktop or from the installed directory. The 
program always begins with its main screen active:

The software may be used with or without Advisor. When used without Advisor, the 
program functions in a Trace Viewer mode to view, analyze, and print captured protocol 
traffic.

When the program is used with the Advisor Protocol Analyzer attached to the computer, 
you can set trigger conditions, record, monitor and analyze the activity of your USB bus.

4.6 Making a Recording
After installation, the software is configured to make a Snapshot recording of USB traffic. 

To make your first recording of traffic, see “Your First USB Recording” on page 16.
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Chapter 5:  Software Overview
The LeCroy USB Advisor™ software may be used with or without the Analyzer hardware. 
When used without the Analyzer hardware, the program functions in a Trace Viewer 
mode to view, analyze, and print captured protocol traffic from Advisor Analyzers. The 
software also allows you to view trace files created by the LeCroy Chief™, Detective™, 
and Inspector™. Opening a file created with any of these Analyzers displays a screen 
asking if you want to convert the old file to the new format under the name convert.usb.

When the program is used with the USB Advisor Analyzer attached to the computer, you 
can monitor and analyze the activity of your USB branch from either of the USB ports on 
the front of the Analyzer.

5.1 Starting the Advisor Program
To start the USB Advisor Program:

Step 1 Click Start > Programs > LeCroy > LeCroy USB Advisor. 

5.2 Tool Tips
Tool tips provide useful information about fields and buttons. 

In some cases, tool tips spell out acronyms used in cells. To display a tool tip, position 
the mouse pointer over an item.
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5.3 The Main Display Windows
While some of the Analyzer’s Main Display window options are familiar, many contain 
options specific to the Analyzer program.

Menu Function
File

Open Opens a file.
Close Closes the current file.
Save As Saves all or a range of packets from the current file.
Print Prints part or all of the current traffic data file.
Print Preview Produces an on-screen preview before printing.
Print Setup Sets the options for the current or new printer.
Edit Comment Creates or edits the Trace file comment field.
Export>>
Packets to Text 
(Packet View Format)
Packets to .CSV 
(Comma Separated 
Values for Excel, etc.) 
Format)
Packets to Host Traffic 
Generator Text File 
(.utg)
Packets to Device 
Emulation Traffic 
Generation Text File 
(.utg)
Data

Saves all or part of a trace to a text file or generator file.
Saves trace as text file in Packet View Format.

Saves trace as a comma-separated-values text file for use 
with Microsoft® Excel.

Saves trace as script file that can be used by a Generator to 
generate a trace.

Exports packets to Device Emulation files. This option does 
not export transactions.

Exports Transfer data as text or binary file
Merge Trace Files Merges two simultaneously recorded files into a single file. 

(This command does not work if the files were recorded at 
different times).

Compare Endpoint 
Data

Allows you to select two endpoints of different directions with 
the same address and verify that the data OUT/IN is identical 
to the data IN/OUT from the other endpoint. Used when 
running echo-types of tests for data integrity.

Import Imports data from a .vcd file.
Exit Exits the Advisor program.

Setup
Display Options Provides display options such as color, formats, and filters.
Recording Options Provides setup options for recording, triggering events, and 

filtering events.
Setup Analyzer Allows you to update the BusEngine™ and Firmware.
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Record
Start Causes the Analyzer to begin recording USB activity.
Stop Causes the Analyzer to stop recording.
Upload Again... Allows you to upload a different portion of the captured trace 

if the previous upload was only partially uploaded. 
Report

File Information Displays information about the recording such as the number 
of packets and triggering setup.

Error Summary Summarizes the errors throughout the recording. Allows for 
fast navigation to packet with errors.

Timing Calculation Calculates timing between two packets and bus utilization.
Traffic Summary Summarizes the numbers and types of errors, packets, 

transactions, split transactions, and transfers that occurred in 
the open trace.

Bus Utilization Displays graphs of packet length, bus usage, and bus usage 
by device.

Search
Go to Trigger Positions the display to show the first packet that follows the 

trigger event.
Go to Packet/ 
Transaction/Transfer

Positions the display to the packet/transaction/transfer 
number selected in the Go to Packet/Transaction/Transfer 
menu

Go to Marker » Positions the display to the selected marked packet.
Go to » Positions the display to the selected event, condition, value, 

or type
Find Allows complex searches on multiple criteria.
Find Next Repeats the previous Find operation.
Search Direction Allows the search direction to be changed from Forward to 

Backward or vice versa. 

Menu Function
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View
Toolbars Displays a list of available toolbar buttons.
Status Bar Switches display of the Status Bar on or off.
Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed packets within the window.
Hide SOF’s Hides Start of Frames.
Hide NAK’s Hides NAK’d Transactions.
Hide Devices Hides packets belonging to specified devices by address and 

endpoint.
Hide Chirps Hides the Chirp-K and Chirp-J Bus conditions. These are 

recorded only in USBTracer.
Apply Decoding 
Scripts

Decoding scripts set the values of the display and recording 
options for optimum views of trace information from specific 
vendors or classes of data. This menu option allows you to 
select the vendor or class of data for the request recipients 
and endpoints listed in the Request Recipients and Endpoints 
menu. You can keep the settings across recordings.

Packet Level Displays Packets.
Transaction Level Displays Transactions.
Split Transaction 
Level

Displays Split Transactions.

Transfer Level Displays Transfers.
HWA Segment Level Displays Host Wire Adapter Segments
HWA Transfer Level Displays Host Wire Adapter Transfers
DWA Segment Level Displays Device Wire Adapter Segments
DWA Transfer Level Displays Device Wire Adapter Transfers
PTP Transaction 
Level

Displays PTP Transactions

PTP Object Level Displays PTP Objects
PTP Session Level Displays PTP Sessions
Refresh Decoding Forces the software to re-apply decoding to transactions and 

transfers. This option is useful if you have applied decoding 
mapping, which helps fully decode a sequence of transfers, 
as is the case with Mass Storage decoding.

Window
New Window Switches display of the Toolbar on or off.
Cascade Displays all open windows in an overlapping arrangement.
Tile Horizontal Displays all open windows in a side-by-side arrangement.

Tile Vertical Displays all open windows in a top-to-bottom arrangement.

Arrange Icons Arranges minimized windows at the bottom of the display.

Windows... Displays a list of open windows.

Menu Function
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5.4 View Options
You can hide, display, or reset toolbars by selecting View > Toolbars from the menu bar.

Resetting the Toolbar
From time to time (such as following a software upgrade), it is possible for the buttons on 
the toolbar to not match their intended function. You can reset the toolbar by performing 
the following steps: 

Step 1 Select View > Toolbars from the menu bar.

Help
Help Displays online help. 

Help Topics Displays online help. You can also select F1.
Update License Opens a dialog box for updating your LeCroy license. 
Display License 
Information

Displays information related to licensing.

About USB Advisor Displays version information about USB Advisor.

Menu Function
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Step 2 Select Customize from the sub-menu to display the Customize dialog box. 

Step 3 Select the Toolbars tab to list the toolbars.

Step 4 Click the Reset All button. The toolbar resets to the factory defaults.



USBAdvisor User Manual Chapter 5: Software Overview

LeCroy Corporation  33

Toolbar

The Tool Bar provides quick access to the most popular program functions. Tool tips 
briefly describe the functionality of each icon. 

Open file
 
 Hide chirps

Save As
 
 Assign High Level Decodes

Preview Find

Print… Find Next

Setup Record Options File Information Report

Setup Display Options Error Report

Start Recording Timing and Bus Usage Calculations

Stop Recording Traffic Summary

Zoom In Bus Utilization

Zoom Out Display Packets

Wrap Display Transactions

Hide SOFs Display Split Transactions

Starts the Trace Navigator Display Transfers

Partial Upload Display Host Wire Adapter Segments

Hide NAK’d transactions Display Host Wire Adapter Transfers
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5.5 Status Bar
The Status Bar is located at the bottom of the main display window. Depending on the 
current activity, the bar can be divided into as many as four segments.

Recording Progress
When you begin recording, the left-most segment of the Status Bar displays a Recording 
Progress Indicator.

As recording progresses, the Progress Indicator changes to reflect the recording 
progress graphically:

• In the Progress Indicator, a black vertical line illustrates the location of the 
Trigger Position you selected in Recording Options. 

• Pre-Trigger progress is displayed in the field to the left of the Trigger Position 
in the before-Trigger color specified in the Display Options. 

• When the Trigger Position is reached, the progress indicator wiggles as it 
waits for the trigger. 

• After the trigger occurs, the field to the right of the Trigger Position fills in the 
after-Trigger color specified in the Display Options. 

• When recording is complete, the upper half of the progress indicator fills in 
white, indicating the progress of the data upload to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger Event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate that not all 
the expected data was recorded pre-Trigger. 

• When you click Stop before or after a Trigger Event, the Progress Bar adjusts 
accordingly to begin uploading the most recently recorded data.

Hide Devices Display Device Wire Adapter Segments

Display PTP Transactions Display Device Wire Adapter Transfers

Display PTP Objects Display PTP Sessions



USBAdvisor User Manual Chapter 5: Software Overview

LeCroy Corporation  35

The Progress Bar fills with color in proportion to the specified size and actual rate at which 
the hardware is writing and reading the recording memory. However, the Progress 
Indicator is normalized to fill the space within the Status Bar.

Recording Status
During recording, the current Recording Status is displayed in the next segment. When 
you activate the Record function, this segment flashes one of the following messages 
(depending on the selected Recording Options): 

• Trigger?
• Triggered!
• Uploading

After recording stops: 

• The flashing message changes to Uploading data–x% done (x% indicates 
the percentage completion of the data uploading process). 

• The traffic data is copied to disk (overwriting any previous version of this file) 
using the default file name data.usb. If two channels of traffic are recorded, 
Advisor creates two files:data.usb and data_classic.usb. You can specify a 
file name in the Recording Options dialog box.

To abort the upload process: 

• Press Esc on your keyboard
OR

• Again click  in the Tool Bar. 

Note: While uploading is in progress, clicking the stop button again brings up a dialog 
opens a dialog that allows you to do a partial upload, flush the current file, keep what has 
uploaded at this point, and to continue uploading. 

You are asked if you want to keep or discard the partially uploaded data.

When the data is saved, the Recorded Data file appears in the main display window and 
the Recording Status window is cleared. 

• If the recording resulted from a Trigger Event, the first packet following the 
Trigger (or the packet that caused the Trigger) is initially positioned second 
from the top of the display.

• If the recording did not result from a Trigger Event, the display begins with the 
first packet in the traffic file.
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The Partial Upload button is enabled when you have partially uploaded data. When you 
click this button, a dialog box appears that gives you options on what portion of data you 
want to upload again. 

When the data is saved, the Recorded Data file appears in the main display window and 
the Recording Status window is cleared. 

• If the recording resulted from a Trigger Event, the first packet following the 
Trigger (or the packet that caused the Trigger) is initially positioned second 
from the top of the display.

• If the recording did not result from a Trigger Event, the display begins with the 
first packet in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status Bar displays Recording 
activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity being 
recorded. If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Note:  If packets are filtered from the recording or data are truncated, the recording 
activity is reduced.

Search Status
The rightmost segment displays the current search direction: Fwd (forward) or 
Bwd (backward). 
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5.6 Navigation Tools
You can zoom in and out, and wrap packets/transactions/transfers to fit within the screen 
using the following buttons:

Zoom In
Zoom In increases the size of the displayed elements, allowing fewer (but larger) packet 
fields per screen. 

• Click  on the Tool Bar.

Zoom Out
Zoom Out decreases the size of the displayed elements, allowing more (but smaller) 
packet fields per screen. 

• Click  on the Tool Bar.

Wrap
Select Wrap to adjust the Trace View so that packets fit onto one line. If a packet is longer 
than the size of the window, the horizontal scroll bar can be used to see the hidden part 
of the packet.

• Click  on the Tool Bar or select Wrap under View on the Menu Bar.
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5.7 Advisor Analyzer Keyboard Shortcuts
Several frequently-used operations are bound to keyboard shortcuts.

Operation Key Combination

Trace Navigation

Find Next F3

Search Backwards Ctrl+B

Search Forwards Ctrl+F

Jump to First Packet Ctrl+Home

Jump to Last Packet Ctrl+End

Go to Any Error Shift+E

Go to Channel 0 Ctrl+Shift+0

Go to Channel 1 Ctrl+Shift+1

PID

Go to ACK Shift+A

Go to DATA0 Shift+0

Go to DATA1 Shift+1

Go to DATA2 Shift+2

Go to DATAx Shift+D

Go to IN Shift+I

Go to MDATA Shift+M

Go to NAK Shift+N

Go to NYET Shift+Y

Go to OUT Shift+O

Go to PING Shift+G

Go to PRE/ERR Shift+P

Go to SETUP Shift+S

Go to SOF Shift+F

Go to SPLIT Shift+X

Go to STALL Shift+L



USBAdvisor User Manual Chapter 5: Software Overview

LeCroy Corporation  39

Bus Conditions

Go to Reset Shift+T

Go to Resume Shift+6

Go to SE0 Shift+Z

Go to SE1 Shift+7

Go to Keep-Alive Shift+5

Go to Suspend Shift+U

Go to Chirp Shift+C

Go to Full Speed J Shift+J

Go to Full Speed K Shift+K

OTG

Go to SRP Ctrl+Q

Go to HNP Shift+H

Go to VBus Voltage Change Shift+V

Go to OTG Host A Ctrl+Shift+A

Go to OTG Host B Ctrl+Shift+B

Misc.

Marker Menu Ctrl+M

Open File Ctrl+O

Print… Ctrl+P

Record Ctrl+R

Stop Recording Ctrl+T

Open Display Options dialog Ctrl+Shift+D

Open Recording Options dialog Ctrl+Shift+R

Hide SOFs Ctrl+Shift+S

Hide NAKs Ctrl+Shift+N

Hide Chirps Ctrl+Shift+C
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Chapter 6:  Reading a Trace
6.1 Trace View Features

• The LeCroy USB Advisor™ packet view display makes extensive use of color and 
graphics to fully document the captured traffic.

• Packets are shown on separate rows, with their individual fields both labeled and 
color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped (with a resolution 
of 16.67 ns), and highlighted to show the transmitted speed (low-speed, full-speed 
or high-speed).

• Display formats can be named and saved for later use. 
• Pop-up Tool Tips detail the contents of packet fields.
• Data fields can be collapsed to occupy minimal space in the display and you can 

zoom in and out to optimize screen utilization. 
• The display software can operated independently of the hardware and so can func-

tion as a stand-alone Trace Viewer that may be freely distributed.
• High Speed SOFs display Microframes (shown below.)

Microframes
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6.2 Set Marker
You can define a unique marker for each packet. 

To place a marker on a packet: 

Step 1 Left-click Packet # for the packet you wish to mark to display the Packet menu: 

Step 2 Select Set Marker to display the Edit Marker Comment window. 

Step 3 Enter a comment about the packet.

Step 4 Click OK.

A marked packet is indicated by a vertical red bar along the left edge of the packet # 
block: 
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6.3 Edit or Clear Marker
To clear or edit the comments associated with a packet marker: 

Step 1 Left-click Packet # for the chosen packet to display the Packet menu: 

Step 2 To edit the Marker Comment, select Edit Marker Comment to display the Edit 
Marker Comment window. Edit the comment, then click OK: 

Step 3 To clear a Marker, click Clear Marker.
The vertical red Marker bar disappears.
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6.4 View Raw Bits
You can expand a specific packet to view the raw bits in detail. 

To view the raw bits: 

Step 1 Left-click Packet # for the packet to display the Packet menu: 

Step 2 Select Show Raw Bits to display the Raw Bits View for that packet: 

Along the top of the Raw Bits View is a linear strip of the logical bit values with 
corresponding field demarcations. Bit stuffing is displayed in color. Below the logical bit 
values is a representation of the D+/D- signaling complete with NRZ encoding. A scroll 
bar assists in navigation of larger packets. Two buttons under the label Packet are used 
to view previous or next packets. Two buttons under the label Zoom allow you to zoom 
in or out on packets.
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Using the Packet Buttons
The bottom left of the Raw Bits View contains buttons for navigating to different packets 
in the trace. Under Packet, the Prev and Next buttons allow you to show raw bits for the 
previous and forward packets in the trace. 

Using the Stuff Bit Buttons
The bottom center of the Raw Bits View contains a checkbox and buttons for viewing 
Stuff Bits. Select the Show Stuff Bits checkbox and then click the Prev button to view 
previous stuff bits in a trace. Click the Next button to view show the next stuff bits in a 
trace. Under Stuff Bit Error, click the Prev button to view previous stuff bit errors in a 

trace, and click Next to view stuff bits forward in a trace. 

Using the Zoom Buttons
Use the buttons to view larger or smaller views of raw bits. 
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6.5 Expanding and Collapsing Data Fields
You can expand a data field to view it in greater detail or collapse it when you want a more 
compact view. 

Using the Expand/Collapse Data Field Arrows
Data Fields can be easily expanded or collapsed by clicking the small triangular arrows 
on the left side of the data field.

Double-Clicking to Expand/Collapse Data Fields
Data fields can also be expanded or collapsed by double-clicking anywhere in the data 
field.

Expanding or Collapsing All Data Fields
Expand or collapse all data fields by holding down the button for more than a second. 
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Using the Data Field Pop-up Menus
Data fields can be expanded or collapsed by clicking in a data field and selecting Expand 
Data or Collapse Data from the pop-up menu.

To expand and collapse data using the menu: 

Step 1 Left-click Data in the Data packet you want to expand or collapse.

If your Data Trace View is currently expanded, you see the Collapse Data menu: 

If your Data Trace View is currently collapsed, you see the Expand Data menu: 

Step 2 Select the desired Expand Data or Collapse Data menu item.

The Trace View is repositioned with the selected packet(s) adjusted in the format 
you have specified.

Expand or Collapse All Data Fields
All data fields can be expanded or collapsed by selecting Expand All Data Fields or 
Collapse All Data Fields from the data field pop-up menus.
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6.6 View Data Block
The Data Field pop-up menu has an option for viewing the raw bits in a data field. 

To view these bits: 

Step 1 Click in the data field to open the Data Field menu.

Step 2 Select View Data Block to open the Data Block dialog box. 

The View Data Block window has options for displaying the raw bits in different formats:

• Format: Lets you display data in Hex, Decimal, ASCII, or Binary format.
• Show Per Line: Lets you control how many bits are displayed per line.
• Bit Order: Most Significant Bit or Least Significant Bit



USBAdvisor User Manual Chapter 6: Reading a Trace

LeCroy Corporation  49

6.7 Pop-up Tool-tips
Many fields within the trace display pop-up tool-tips when the mouse pointer is 
suspended over them. These tips provide added details about the field. 

6.8 Hide SOF Packets
You can hide Start-of-Frame (SOF) packets that may be uninteresting in a given context 
from a Trace View by clicking the Hide SOF Packets button on the Tool Bar:

• Click  to hide all SOF packets.

6.9 Hide NAKs
You can hide NAKs that may be uninteresting in a given context from a Trace View by 
clicking the Hide NAKs button on the Tool Bar:

• Click  to hide all NAK packets.

6.10 Hide Devices
Click the  to open a tear-off window that allows you to select any address/endpoint 
combination that you want to hide. 

6.11 Hide Chirps
Click the  to hide any Chirp-J or Chirp-K packets recorded in a USBTracer trace. 
Advisor does not record these signals. 
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6.12 Switch to Transactions View
A Transaction is defined in the USB specification as the delivery of service to an 
endpoint. This consists of a token packet, an optional data packet, and an optional 
handshake packet. The specific packets that make up the transaction vary based upon 
the transaction type. 

The program default display mode is Packet View. Before you can view decoded 
transactions, you must switch from Packet View to Transactions View.

To select Transactions View:

Step 1 Click  on the toolbar to redraw the Trace View to display transactions. 

Note:  This menu selection displays a check mark next to Show USB transactions 
when you have selected it. When you want to switch back to Packet View 
mode, right-click anywhere in the trace window and then left-click 
Show USB transactions.
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To switch to Transaction View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options General 
window: 

Step 2 Check Transactions.
Step 3 Click OK.
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6.13 View Decoded Transactions
After you set Display Options, the Trace View screen is re-drawn to display decoded 
transactions in the colors and format you selected. 

When you instruct the Analyzer to display USB transactions, the components of each 
transaction are collected from the current recording and are grouped and indented below 
each decoded transaction. Each row shows a transaction with a unique numeration, a 
label, and color-coded decoding of important data.
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Expanded and Collapsed Transactions
You can expand a specific transaction to view its parts, which are grouped and indented 
below the transaction. 

To expand a transaction: 

Step 1 Left-click the transaction number you wish to view to display the Expand 
Transaction menu: 

Step 2 Select Expand This Transaction.

The screen displays the selected transaction in expanded format.

Note:  The Expand/Collapse transaction feature operates as a toggle: when one 
format is active, the other appears as an option on the Expand/Collapse 
drop-down menu. 

To collapse a transaction, perform the same operation and select Collapse This 
Transaction. 

Note that you can choose to expand or collapse: 

• Only the selected Transaction
OR

• All Transactions.
It is not necessary to use the Expand/Collapse Transactions menu to shift between 
expanded and collapsed views of a transaction: 

• Double-click in the Transaction number field to toggle back and forth between 
collapsed and expanded views.
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6.14 Switch to Split Transaction View
To select Split Transaction View: 

Step 1 Click the  button on the toolbar to redraw the Trace View screen to 
display Split Transactions.

To switch to Split Transactions View from the Menu Bar: 

Step 1 Select Display Options under Setup to display the Display Options General 
window: 

Step 2 Check Split Transactions.

6.15 Switch to Transfer View
A Transfer is defined in the USB specification as one or more transactions between a 
software client and its function. USB transfers can be one of four kinds: Control, Interrupt, 
Bulk, and Isochronous. Advisor is capable of displaying all four types.

The default display mode is Packet View. Before you can view decoded transfers, you 
must switch from Packet View (or Transaction View) to Transfer View.

To select Transfer View: 

Step 1 Click  on the toolbar to redraw the Trace View screen to display Transfers.

Note:  Selecting Show USB transfers adds a check next to this menu item. If you 
want to return to Packet View, open the menu and reselect Show USB 
transfers. This action removes the check and returns the display to Packet 
View.

To switch to Transfer View from the Menu Bar: 

Step 1 Select Display Options under Setup to display the Display Options General 
window: 

Step 2 Check Transfers.
Step 3 Click OK.
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6.16 View Decoded Transfers
Once you set Display Options, the Trace View screen is re-drawn to display decoded 
transfers in the colors and format you selected.

When you instruct the Analyzer to display USB transfers, the components of each 
transfer are collected from the current recording and are grouped below each decoded 
transfer. Each transfer row shows a transfer with a unique numeration, a label, and 
color-coded decoding of important data.

To view decoded transfers, select Transfer Level from the View menu. 

Expanded and Collapsed Transfers
You can expand a specific transfer to view its parts, which are grouped and indented 
below the transfer. 

To expand a transfer: 

Step 1 Left-click the transfer number you wish to view.

You see the Expand Transfer menu:
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Step 2 Select Expand This USB Transfer to display the selected transfer in expanded 
format. 

Note:  The Expand/Collapse transfer feature operates as a toggle. When one 
format is active, the other appears as an option on the Expand/Collapse 
drop-down menu. 

To collapse a transfer, perform the same operation and select Collapse This USB 
Transfer. 
Note that you can choose to expand or collapse 

• Only the selected Transfer
OR

• All Transfers
It is not necessary to use the Expand/Collapse Transfers menu to shift between 
expanded and collapsed views of a transfers. Double-click in the Transfer number field 
to toggle back and forth between collapsed and expanded views.

6.17 Decoding Protocol-Specific Fields in Transactions 
and Transfers

When transfers or transactions are displayed, the fields in setup transactions or control, 
interrupt, and Bulk transfers by default do not get decoded and are shown in hexadecimal 
values. The exceptions are setup transactions and control transfers for standard USB 
device requests which are always decoded.

In order to show specific decoding for class- and vendor-specific device requests and 
endpoints, you have to use the decoding association mechanism that is described in 
Chapter 9 on decoding. When you have performed the association, you see the 
protocol-specific fields of transfers and transactions decoded in the trace view.
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6.18 Switch to Host Wire Adapter Segment View
A Host Wire Adapter Segment is one or more transfers between a PC and a host wire 
adapter. To view host wire adapter segments, switch to the Host Wire Adapter Segment 
trace viewing level.

To select the Host Wire Adapter Segment trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Host Wire Adapter Segment.
OR

• Select Setup > Display Options to display the Display Options window, 
check HWA Segment, and then click OK.

The program redraws the trace view.
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6.19 Switch to Host Wire Adapter Transfer View
A Host Wire Adapter Transfer is one or more wire adapter segments or one or more 
transfers between a PC and a host wire adapter. To view host wire adapter transfers, 
switch to the Host Wire Adapter Transfer trace viewing level.

To select the Host Wire Adapter Transfer trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Host Wire Adapter Transfer.
OR

• Select Setup > Display Options to display the Display Options window, 
check HWA Transfer, and then click OK.

6.20 Switch to Device Wire Adapter Segment View
A Device Wire Adapter Segment is one or more transfers between a PC and a device 
wire adapter. To view device wire adapter segments, switch to the Device Wire Adapter 
Segment trace viewing level.

To select the Device Wire Adapter Segment trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Device Wire Adapter Segment.
OR

• Select Setup > Display Options to display the Display Options window, 
check DWA Segment, and then click OK.

6.21 Switch to Device Wire Adapter Transfer View
A Device Wire Adapter Transfer is one or more wire adapter segments or one or more 
transfers between a PC and a device wire adapter. To view device wire adapter transfers, 
switch to the Device Wire Adapter Transfer trace viewing level.

To select the Device Wire Adapter Transfer trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Device Wire Adapter Transfer.
OR

• Select Setup > Display Options to display the Display Options window, 
check DWA Transfer, and then click OK.

The program redraws the trace view.
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6.22 Switch to PTP Transactions
The Analyzer supports the Picture Transfer Protocol (PTP) and also supports the 
Media Transfer Protocol (MTP), which is an extension of PTP. The Analyzer can track 
PTP transactions, object transfers, and sessions.

A transaction is a standard sequence of phases for invoking an action. In PTP, an 
Initiator-initiated action provides input parameters, responses with parameters, and 
binary data exchange, and is a single PTP Transaction. Also, a single Asynchronous 
Event sent through the interrupt pipe is a single PTP Transaction. 

The PTP Transaction trace viewing level is the lowest PTP level.

To view PTP transactions, switch to the PTP Transaction trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Transaction.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Transaction, and then click OK.

6.23 Switch to PTP Object Transfers
A logical object on a device has a unique 32-bit identifier (object handle). The 
object handle is also unique for the session (defined below). An object transfer contains 
all the transactions for an object handle. In PTP, all of an object handle’s 
PTP Transactions are a single PTP Object Transfer. 
A PTP Object Transfer can include both PTP Transactions that involve an 
Initiator-initiated action (for example, GetObject, DeleteObject, and GetObjectInfo 
transactions) and PTP Transactions that involve a single Asynchronous Event sent 
through the interrupt pipe.

The PTP Object Transfer trace viewing level is the middle PTP level.

To view PTP object transfers, switch to the PTP Object Transfer trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Object.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Object, and then click OK.
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6.24 Switch to PTP Sessions
A session is a state of persisting communication between a device and a host during 
which the connection is continuous and the login and other communication parameters 
do not change. A session begins with an OpenSession operation, which establishes the 
communications connection and parameters, and ends with a CloseSession operation. 

A session contains all object transfers (and their transactions), plus all transactions that 
do not belong to object transfers, between an OpenSession operation and a 
CloseSession operation. For PTP, all PTP Object Transfers and all PTP Transactions 
that occur from the OpenSession operation to the CloseSession operation is a single 
PTP Session. 

The PTP Session trace viewing level is the highest PTP level.

To view PTP sessions, switch to the PTP Session trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Session.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Session, and then click OK.
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6.25 Using the Trace Navigator
You can use the Trace Navigator to show the structure of the 
entire trace from different points on the Trace view. This way you 
can refine the trace view to a packet range in the trace that is 
most interesting to you. This range can be set by you to show 
smaller parts of the trace. 
 

To display the Navigator bar, click  in the toolbar.You can 
also select the Navigation Bar checkbox in the Display Options 
General window to have the Navigator open whenever you open 
the Trace software. 

The Navigator bar can be repositioned in the trace and can be 
oriented horizontally or vertically, docked or undocked by 
dragging the parallel bars at the top or side of the Navigator bar. 
By default, the Navigator bar appears vertically to the right of the 
trace window when opened. 

The Navigator bar represents different types of trace information 
in the order of the packets. The top of each bar corresponds to 
the first packet in the trace, and the bottom corresponds to the 
last packet. The Navigator bar is made up of three parts: 
Pre and Post-Trigger traffic, Errors, and Types of Traffic. 

At any time, a line in the navigator bar of one pixel in height 
represents a fraction of the trace data. If the Navigation bar is 
400 pixels high, then each bar in this example would represent 
1/400 of the trace. If the trace had 4000 packets total, each bar 
would represent ten packets. In the Types of Traffic portion of the 
navigation bar, the color of the bar would be that of the most 
important item in those ten packets. See “Navigator Bar 
Attributes” on page 63. 

Drag the yellow caret, at the top or bottom, to set the packet 
range. When you move the caret, a message shows the packet 
range.

The blue caret indicates the current packet position in the trace 
view.
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Right-click the Navigator to display the pop-up menu. 

• Pre/Post Trigger, Errors, or Types of Traffic: Shows or hides traffic 
information in the Navigator. 

• Legend: Shows or hides Trigger, Error, and Traffic Type categories in the 
Navigator. 

• Set Range to Whole Trace: Sets packet range to the entire trace.
• Set range near Packet number: Sets the packet range near the packet 

where your mouse pointer is positioned in the Navigator bar. 
• Recent Ranges: Displays a history of ranges that were previously selected. 
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Navigator Bar Attributes

The traffic types are shown in order of importance. For example, if a NAK’d transaction 
occurred in the same sample area as a SOF, the NAK would take precedence, and the 
Navigator would show the black bar.

6.26 Edit Comment
You can create, view, or edit the 100-character comment field associated with each 
Trace file. The comments are visible in the Windows® Explorer if the Comments attribute 
is included in the Details view. 

Step 1 Select Edit Comment under File on the Menu Bar to display the Edit comment 
for Trace file window: 

Step 2 Create, view, or edit the comment.

Step 3 Click OK.
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Chapter 7:  Searching Traces
The Search feature provides options for searching recorded traffic to find specific packets 
based on triggering status, packet number, marking, or content. 

To view the Search options: 

• Click Search in the Menu bar to display the Search drop-down menu.

7.1 Go to Trigger
Note:  Go to Trigger is enabled only when a trigger has created the traffic file.

To display a Trigger Event: 

• Select Go to Trigger under Search on the Menu Bar.
The Trace View is repositioned to the first packet following the Trigger event. This packet 
is at the top of the screen.
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7.2 Go to Packet/Transaction/Transfer
To display a specific packet: 

Step 1 From the menu bar, select the command 
Search > Go to Packet/Transaction/Transfer to display the Go to Packet 
window: 

Step 2 Select the desired viewing level (packet, transaction, etc.) from the drop-down 
menu next to the words Go to.

Step 3 Enter the number of the packet to display.

Step 4 Click OK.
The Trace View is repositioned with the selected packet at the top of the screen.

7.3 Go to Marker
To instruct the Analyzer to display a marked packet: 

Step 1 Select Go to Marker under Search on the Menu Bar to display a drop-down 
menu listing the marked packets in that Trace View: 

Step 2 Select the desired packet from the displayed list.

The Trace View is repositioned with the selected packet at the top of the screen.

Note:  The Go to Marker feature functions in conjunction with the Set Marker 
feature. The comments within the parentheses following each marked 
packet are added or edited with the Set Marker feature. Please refer to Set 
Marker in Reading a Trace.
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7.4 Go To
The Go To feature takes you directly to an event in a Trace.

Step 1 Select Go To under Search on the Menu Bar to display the Go To drop-down 
menu: 

Step 2 Select an event and enter the necessary information.
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Packet IDs (PIDs)

Select the type of packet.
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Errors
The Errors menu allows you to search for five different types of error: PID, CRC5, 
CRC16, Packet Length, and Stuff Bits. Menu items appear in bold if they are present in 
the trace or grayed out if not present in the trace, as shown in the example below.

Data Length
Allows you to search for data packets of particular lengths. Lengths are displayed in 
Bytes in a drop down menu as shown below. Selecting a length moves the display to the 
next instance of that packet length.
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Addr & Endp
The Addr & Endp feature allows you to search for the next packet which contains a 
particular address and endpoint. All available address endpoint combinations are 
displayed in the pull down menu. 
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Bus Conditions
Allows you to search by bus conditions such as traffic speed, reset, and suspend. All 
available bus conditions are displayed in the pull down menu.
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On-The-Go
Allows you to search for USB On-The-Go conditions. USB On-The-Go conditions are 
listed in the drop-down menu. 

Channel
Allows you to search by 0(Hi-Speed) and 1(Classic-Speed). 
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7.5 Find
Find allows searches to be conducted on an open trace using one or more criteria. You 
can search by packet, transactions, split transaction, transfer, by packet type and by 
fields within packets. 

Find is run by selecting Search > Find or by clicking on the toolbar. 

Searches can combine criteria using the options Intersection and Union. Intersection 
creates AND statements such as "Find all packets with x AND y." Union creates OR 
statements such as "Find all packets with x OR y."

You can also perform searches whereby packets or events are excluded from a trace. 
The Exclusion allows searches to be conducted.

To perform a search: 

Step 1 Select Find... under Search on the Menu Bar

OR

Click  in the Tool Bar to display the User-Defined Find Events screen: 

Step 2 Select Packets, Transactions, Split Transactions, Transfers, HWA 
Segments, HWA Transfers, DWA Segments, DWA Transfers, 
PTP/MTP Transactions, PTP/MTP Objects, or PTP/MTP Sessions from the 
top left list box to list that type of event in the Events Group box.

Step 3 Select one or more events from the Events Group box.
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Step 4 Select one of the following options: 

• Union: Find all packets matching ANY of the specified events. 

• Intersection: Find all packets matching ALL of the specified events. 

• Exclusion: Exclude packets matching any of the specified events. 
Exclusion works with the other two options: Select Union AND Exclusion 
(=Exclude packets with ANY of the following fields) or Intersection AND 
Exclusion (=Exclude packets with ALL of the following fields.) 

Step 5 If desired, set the search Direction and Origin.

Step 6 Click OK.

After the search finishes, the packets meeting the search criteria are displayed.

7.6 Find Next
To apply the previous Find parameters to the next search: 

• Select Find Next under Search on the Menu Bar.
OR

• Click  on the Tool Bar.

7.7 Search Direction
Toggles the search forward or backwards. The current direction is indicated in the menu.
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Chapter 8:  Display Options
You can select what information to display in CATC Traces using the Display Options 
window.

To open the Display Options window: 

• Select Display Options under Setup on the Menu Bar.
OR

• Click  on the Tool Bar. 

You can select General, Color/Format/Hiding, and Level Hiding display options. The 
following sections describe these display options.
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8.1 General Display Options
You specify the main Trace View information types and settings using General Display 
Options (see figure on previous page): 

• Zoom Level: Zooms out from 100% (default) to 10% or zooms in from 100% 
to 200%.

• Enable Tips: Pops up text when you position the cursor over a field.
• Wrap: Wraps lines of traffic information instead of truncating lines at the right 

edge of the display.
• Right click cell context menu: By default, clicking the left mouse button on a 

field heading displays a context-sensitive pop-up menu providing commands 
about the field and clicking the right mouse button pops up a menu with 
display options. After selecting this option, clicking the right mouse button on 
a field heading displays the context-sensitive pop-up menu and clicking the 
left mouse button does nothing.

• Hierarchy Lines: Displays lines on the left side of Trace View showing the 
hierarchy from Packets to Transactions to Split Transactions to Transfers if 
you show higher-level decodes.

• Timestamp Position: Aligns the Timestamp field At the beginning (in a 
column on the left side of the Trace View), At the end (in a column on the left 
side of the Trace View), or Merge with Packet/Transaction/Translation. 
Selecting this option allows easier comparison with previous or following 
timestamps.

• Expand Packet Data Fields by default: Displays packet data fields in 
expanded mode. If this option is not selected, packet data fields display in 
collapsed mode, and you can expand them manually.

• Allow any Toggle value after Bus Reset (Int and Bulk Endpoints): 
Depending on the device, after Bus Reset the endpoint toggle state might or 
might not be reset. Selecting this option prevents display of a toggle violation 
error. 

• Expand Script-Based Decoded Info by default: Displays decoded transfer 
fields in expanded mode. If this option is not selected, decoded transfer fields 
display in collapsed mode, and you can expand them manually.

• 2-stage SOF Hiding: You can display all SOFs, hide all SOFs, or hide empty 
SOFs (show only SOFs with endpoint traffic and hide empty frames). 
Selecting this option allows you to hide empty SOFs with one click of the Hide 
SOF button or hide all SOFs with two clicks of the Hide SOF button.

• Use new Std Reqs & Descriptors Scripts: Use dynamically loaded .DEC 
files (rather than .REQ and .DSC files) for decoding Class and Vendor 
requests or endpoints. 
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• Analysis Tools
• Error Report: Displays the Errors section of the Traffic Summary 

window. 
• Timing Calculator: Displays the Timing Calculator window from the 

beginning of a packet or marker to the beginning of another packet or 
marker, including Total Time unit, Bus Utilization Time and Bandwidth, 
and selected Global, Low Speed, Full Speed, High Speed, 
Transactions, and Devices. 

• Traffic Summary: Displays the Traffic Summary window, showing all 
reports, including Packets, Transactions, Transfers, and Errors. 

• Bus Utilization: Displays the Bus Utilization window, including Packet 
length, Bus usage, and Bus usage by device. 

• Navigator: Displays the Navigation bar, including Pre/Post Triggers, 
Errors, and Types of Traffic. 

• Trace Viewing Level: Displays Packets, Transactions, Split Transactions, 
Transfers, Host Wire Adapter Segments, Host Wire Adapter Transfers, 
Device Wire Adapter Segments, Device Wire Adapter Transfers, 
PTP Transactions, PTP Objects, and PTP Sessions.

• Fonts: Sets the font type and bold or italic style for Fields and Data.
• Configuration Name: You can name the current set of Display Options 

values for use with an .opt file. (The options file can have a different name.)
• Restore Factory Presets: Sets all Display Options values to the installed 

values. 
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8.2 Color/Format/Hiding Display Options
To modify the colors, formats, and hiding options, select the Color/Format/Hiding tab. 



USBAdvisor User Manual Chapter 8: Display Options

LeCroy Corporation  79

Color Display Options
The program uses a default set of colors for each type of data in each group of data. The 
colors and color combinations are appropriate for most graphic systems. You can alter 
any color.

To specify a color for an information type, in the Color/Format/Hiding tab, select a row 
(such as Data) in the Group and Color column and expand it. 

Select a data type (such as Data Length) in the Group, then select a color in the Color 
section, using Standard or Custom colors. Use a bright color for each important field. 
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To customize colors, use the Custom tab.

Note:  You cannot change color of an Invalid Data (packet error) field. It is 
permanently set to red.

Formats Display Options
For each type of data in each group of data, the program has a default data format. 
Examples of number data formats are Bin (binary), Dec (decimal), and Hex 
(hexadecimal). Examples of date and time data formats are Hex uFrame, Dec uFrame, 
Date & Time, Time, Bit Time, seconds, microseconds, and nanoseconds. An example of 
a text data format is ASCII. You can alter some data formats.

To specify a data format for an information type, in the Color/Format/Hiding tab, select a 
row (such as Packet Fields) in the Group and Color column and expand it. 
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Select a data type (such as PID Types) in the Group: 

Select a format in the Format section. The following formats are available for PID Types: 

If available, select Bit Order in the Bit Order section. The options are MSB to LSB or LSB 
to MSB.

Hiding Display Options
By default, no data is hidden. You can hide any group of data and any type of data. You 
can hide transactions, SOFs; NAKs; High, Full, or Low Speed packets; traffic from one or 
both recording channels; and Addresses and Endpoints.

To hide one or more fields, select the Group and Data type in the Group and Color 
column, then click the Hidden checkbox in the display or the Hidden checkbox in the 
Hidden section of the Format section. 
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8.3 Level Hiding Display Options
By default, no data packets, transactions, or bus conditions are hidden. You can hide: 

• Start of Frame packets
• NAK’ed transactions
• Chirp and SEO Bus conditions
• High, Full, or Low Speed packets
• Channel 0 or Channel 1 packets

Select the Level Hiding tab, then select the data types to hide.
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8.4 Saving Display Options
You can save a set of Display Options values, make a set the default settings, or use a 
saved set of values with the commands at the bottom of the Display Options window: 

• To save the current Display Options values in an options file for use in future 
sessions, click Save. Enter a file name without a file name extension. The 
program adds the .opt extension. (The file must have an .opt file name 
extension.)

• To load a previously saved .opt file, click Load and select a file name.
• To save the current Display Options values in the default.opt options file for 

use as the default display options, click Save as Default. (Do not delete the 
default.opt file.)

• To apply the current Display Options values, click Apply. The Display Options 
window remains open.

• To apply the current Display Options values and close the Display Options 
window, click OK.

• To cancel unsaved changes to display values and exit the Display Options 
window, click Cancel. 
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Chapter 9:  Decode Requests
9.1 Class and Vendor Definition Files

LeCroy Analyzers use script files to decode class and vendor requests. The script files 
are read when the application is initialized. After reading, the Analyzer decodes class and 
vendor requests as instructed by the files.

.DEC files represent the new method of decoding. DEC stands for "decoder" and 
describes both Class and Vendor requests in a C-like language. Each .dec file stores an 
endpoint or request decode. When the application starts, these files are loaded 
dynamically. Subdirectories are supported. 

For information about legacy script decoding, see Appendix A “Legacy Script Decoding” 
on page 143.

Note: The .dec files listed in the following table are in the Scripts directory under the 
installation directory: 

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID

Audio Class decoding 2.0
     AudioClass\Audio1.0Requests.dec
     AudioClass\Audio2.0Requests.dec

Audio 01h

Communications and CDC Control
Direct Line Control Model
Abstract Control Model
Telephone Control Model
Multi-Channel Control Model
CAPI Control Model
Ethernet Networking Control Model
ATM Networking Control Model
Wireless Handset Control Model
Device Management Model
Mobile Direct Line Model
OBEX Model
Communication Device Subclass/EEM
     Communications\CommRequests.dec
     Communications\CommInterrupt.dec
     Communications\CommCDCEEM.dec

CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID

02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h

01h
02h
03h
04h
05h
06h
07h
08h
09h
0Ah
0Bh
0Ch
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HID (Human Interface Device)
HUT (HID extension)
Monitor (HID extension)
Physical Interface  
     (force-feedback extension to HID)
Point of Sale Devices (HID extension)
Power (HID extension)
     Hid\hid.dec
     Hid\Hid_Req.dec

HID
HID
HID
HID 

HID
HID

03h
Extension
Extension
Extension 

Extension
Extension

  

Physical
     Hid\hid.dec
     Hid\Hid_Req.dec

HID 05h

Still Imaging Class
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

06h 01h 01h

Printer
     Printer\Printer_req.dec

Printer 07h 01h xxh

Mass Storage Mass Storage 08h

SCSI/Bulk Protocol
     MassStorageClass\MS_BulkOnly_Requests.dec
     MassStorageClass\MS_BulkOnlySCSIInEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec

Mass Storage
   SCSI Bulk

08h

UFI (floppy)/CBI Protocol
     MassStorageClass\MS_UFI_CBI_Requests.dec
     MassStorageClass\MS_UFI_CBI_BulkInEndp.dec
     MassStorageClass\MS_UFI_CBI_BulkOutEndp.dec
     MassStorageClass\MS_UFI_CBI_InterruptEndp.dec

MassStrg Class
   UFI CBI

08h

Hub support
     HubClass\HubClassRequests.dec
     HubClass\HubClassStatusEndpoint.dec

Hub Class 09h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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Picture Transfer Protocol (PTP)
[Photographic and Imaging Manufacturers
Association (PIMA) 15740 and ISO 15740]
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

Extension

Communications Device Class (CDC) Data
     Communications\CDCDataBulkIn_wCTE.dec
     Communications\CDCDataBulkIn_wPW.dec
     Communications\CDCDataBulkIn_wPW_wCTE.dec
     Communications\CDCDataBulkOut_wCTE.dec
     Communications\CDCDataBulkOut_wPW.dec
     Communications\CDCDataBulkOut_wPW_wCTE.dec
     Communications\CDCDataIsochIn_wCTE.dec
     Communications\CDCDataIsochIn_wPW.dec
     Communications\CDCDataIsochIn_wPW_wCTE.dec
     Communications\CDCDataIsochOut_wCTE.dec
     Communications\CDCDataIsochOut_wPW.dec
     Communications\CDCDataIsochOut_wPW_wCTE.dec

0Ah 00h

Smart Card (CCID)
     SmartCard\CCIDBulkIn.dec
     SmartCard\CCIDBulkOut.dec
     SmartCard\CCIDInterrupt.dec
     SmartCard\CCID_req.dec
     SmartCard\ICCDBulkIn.dec
     SmartCard\ICCDBulkOut.dec
     SmartCard\ICCDInterrupt.dec
     SmartCard\ICCD_req_Ver.A.dec
     SmartCard\ICCD_req_Ver.B.dec

CCID and ICCD 0Bh

Video Class (UVC) decoding 1.1 (currently at 1.0)
VIDEO CONTROL
VIDEO STREAMING
VIDEO INTERFACE COLLECTION
     VideoClass\VideoBulkIn.dec
     VideoClass\VideoBulkOut.dec
     VideoClass\VideoInterrupt.dec
     VideoClass\VideoIsochIn.dec
     VideoClass\VideoIsochOut.dec
     VideoClass\Video1.0Requests.dec
     VideoClass\Video1.1Requests.dec

Video
Video
Video

0Eh
0Eh
0Eh
0Eh

01h
02h
03h

00h
00h
00h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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You can create your own .dec file for a Class or Vendor Request. For more information 
on the format of these Script Decoder files and the Script Decoding language, read the 
Script Decoder Manual.

Wireless Controller
BT
UWB
Remote Network Driver Interface Specification (RNDIS)
Host Wire Adapter
Device Wire Adapter
Device Wire Adapter Isochronous interface
     WireAdapter\WA_DataInEndpoint.dec
     WireAdapter\WA_DataOutEndpoint.dec
     WireAdapter\WA_NotifEndpoint.dec
     WireAdapter\WA_Requests.dec
     WireAdapter\WA_Radio_Requests.dec
     WireAdapter\WA_RadioNotifEndpoint.dec

HCI
WA Radio Control
Remote NDIS
Wire Adapter Class
Wire Adapter Class
Wire Adapter Class

E0h
E0h
E0h
E0h
E0h
E0h
E0h

01h
01h
01h
02h
02h
02h

01h
02h
03h
01h
02h
03h

Miscellaneous Device Class
Interface Association Descriptor 
 

Wire Adapter Multifunction 
     Peripheral programming interface
Cable Based Association Framework (CBAF) Requests 

     Standard\StandardRequests.dec
     IEEE\IEEECompanies.dec
     Virtual\VirtualDATAIn.dec
     Virtual\VirtualDATAOut.dec
     Virtual\VirtualUARTIn.dec
     Virtual\VirtualUARTOut.dec
     AssociationFrameworks\  
          WUSB_CableBasedAssociation.dec

IrDA Bridge
ATAPI
IP
HTTP

Standard,  
   so no decoder 
   method needed
Wire Adapter Class 

Association 
   Frameworks

 

IrDA Bridge
ATAPI
IP
HTTP

EFh
EFh 
 

EFh 

EFh 

 

FEh
08h

02h 
 

02h 

03h 

 

02h
02h

01h 
 

02h 

01h 

 

00h
50h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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9.2 Class/Vendor Decoding Options
You can permanently assign a class or vendor decoding for an address and/or endpoint 
or interface in a trace file. Once assigned, the decoding occurs automatically when you 
display transactions.

Mapping Request Recipient to Class/Vendor Decoding
To assign a decoding group to a request recipient, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB Device Request menu:

Step 2 Select Map Request Recipients to Class/Vendor Decoding to display the 
Request Recipient and Endpoints dialog box: 

The Recipient field shows all Class and Vendor Request Recipients found in the 
trace file. The display shows the Host, Address, and Type (Class or Vendor) for 
the recipient. On the right are the names of Class/Vendor Decoding groups 
currently assigned to recipients. If blank, no decoding is assigned for a recipient. 

Step 3 Select a recipient.
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Step 4 Display the Class/Vendor Decoding Groups drop-down menu.

The drop-down menu lists the defined Class/Vendor request decoding groups. 
The Class/Vendor Decoding Groups are:

• No Decoding
• Audio Class Requests
• Communication Class Requests
• HCI Command
• HID Class
• HID Class Requests
• Hub Class Requests
• Mass-Strg Bulk-Only Requests
• Mass-Strg Class UFI CBI Requests
• Printer Class Requests
• Standard Requests
• Still Image/PTP/MTP/PictBridge Class Requests
• Video Class Requests
• Wire Adapter Radio Control Requests
• Wire Adapter Class Requests

Step 5 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 6 Repeat the previous steps for additional recipients.

Step 7 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 8 Click OK.
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Mapping Endpoint to Class/Vendor Decoding
To assign a Class/Vendor Endpoint decoding, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB Device Request menu.

Step 2 Select Map Endpoint to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoints tab to display the Endpoints dialog box. 

The Endpoint field (Endp) shows all Endpoints found in the trace file. The 
displays shows the Host, Address, and Direction for the recipient. On the right 
are the names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient. 

Step 4 Select an endpoint.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu: 

The Class/Vendor Endpoint Decoding options for an OUT endpoint are: 

• No Decoding
• CCID Bulk Out Message
• Display DATA
• HCI data out
• HCI SCO out
• Mass Strg Bulk-Only SCSI Out Endp
• Mass Strg UFI_CBI Bulk Out Endp
• Still Image/PTP/MTP/PictBridge Bulk Out
• Video Bulk Out
• Video Isoch Out
• Virtual UART
• Wire Adapter Data Transfer Out Endp
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The Class/Vendor Endpoint Decoding options an IN or Interrupt endpoint are: 

• No Decoding
• CCID Bulk In Message
• Communication Class Interrupt Notification
• Display DATA
• HCI data in
• HCI event
• HCI SCO in
• HID In Endp
• Hub Class Status Change Endp
• Mass Strg Bulk-Only SCSI In Endp
• Mass Strg CBI Interrupt Endp
• Mass Strg UFI_CBI Bulk In Endp
• Mass Strg UFI_CBI Interrupt Endp
• Still Image/PTP/MTP/PictBridge Bulk In
• Still Image/PTP/MTP/PictBridge Interrupt
• Video Bulk In
• Video Interrupt
• Video Isoch In
• Virtual UART
• Wire Adapter Radio Notif Endp
• Wire Adapter Data Transfer In Endp
• Wire Adapter Notif Endp

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional endpoints you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request RPipe to Class/Vendor Decoding
Before mapping Request RPipes to Class/Vendor Decoding, you must first assign the 
following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB Device Request menu. 

Step 2 Select Map RPipe to Class/Vendor Decoding to display the Request Recipient 
and Endpoints dialog box.

Step 3 Click the Request RPipes tab to display the Request RPipes dialog box:

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Otg Host, HWA address, and Type (Class 
or Vendor) for the recipient. On the right are the names of Class/Vendor 
Decoding groups currently assigned to recipients. If blank, no decoding is 
assigned for a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Endpoint RPipe to Class/Vendor Decoding
To assign a Class/Vendor Endpoint RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB Device Request menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box: 

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Otg Host, HWA address, and Direction for the recipient. On the right are the 
names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint RPipe.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request DWA RPipe to Class/Vendor Decoding
Before mapping Request DWA RPipes to Class/Vendor Decoding, you must first assign 
the following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB Device Request menu. 

Step 2 Select Map DWA RPipe to Class/Vendor Decoding to display the Request 
Recipient and Endpoints dialog box.

Step 3 Click the Request DWA RPipes tab to display the Request DWA RPipes dialog 
box:

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Otg Host, HWA address, and Type (Class 
or Vendor) for the recipient. On the right are the names of Class/Vendor 
Decoding groups currently assigned to recipients. If blank, no decoding is 
assigned for a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.



USBAdvisor User Manual Chapter 9: Decode Requests

LeCroy Corporation  97

Step 9 Click OK.

Mapping Endpoint DWA RPipes to Class/Vendor Decoding
To assign a Class/Vendor Endpoint DWA RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box: 

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Otg Host, HWA address, and Direction for the recipient. On the right are the 
names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint DWA RPipe.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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9.3 General Options
Commands are transferred on USB using special control transfers called USB Device 
Requests. The Analyzer can decode Device Requests as they are defined in the USB 
specifications and various Device Class and Vendor specifications.

Each USB Device Request is sent using a Control Transfer. Each Control Transfer starts 
with a SETUP transaction.

Decoding USB Device Requests
To decode a USB Device Request: 

Step 1 Left-click the Control Transfer field or the SETUP field of the 
USB Device Request to display the USB Device Request menu: 

Note:  The menus shown in this section are context-sensitive. You may see slightly 
different menus. 

Step 2 To refresh decoding, click Refresh Decoding for this Trace File. Use this option 
to reanalyze all transactions. 

Step 3 To use the previous decoding, click Load most recent decoding mapping. 

This option loads the most recent mapping of endpoints/requests to decoding 
types that was done on a previous trace. If the endpoints of the new trace are the 
same as the last one mapped, the mappings are applied to the current trace. This 
saves the user from having to constantly apply the mapping to a new trace every 
time the application is restarted and a new trace created. 

The ability to retain the mapping from trace to trace DURING an application 
session already exists: the Keep Across Recordings button in the endpoint map 
dialog. This new feature simplifies the process when the application has been 
re-started. 

Note:  You can also change the format, color, and hidden status of fields, using the 
same methods as in Display Options. (See Chapter 6, Display Options.)
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Decoding Standard Requests
To decode a standard request: 

Step 1 From the USB Device Request menu, select Decode Standard Request to 
display the View Fields for Standard Request text box: 

Step 2 To find a word in the text box, click the Find button. Enter the word in the Find 
What field. To use a case-sensitive search, check Match Case. To find only the 
exact word, check Match Whole Word Only. You can search Up or Down. To 
search, click Find Next.

Step 3 To save the View Fields text box as an HTML file, click the Save As button, enter 
a file name in the Save As dialog box, then click Save.

Step 4 To view the previous or next Transfer Control field request of the same request 
type, click Previous or Next.

The View Fields for Standard Request dialog box displays field definitions and values of 
the Standard Request. 
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For field definitions, please refer to the Universal Serial Bus Specification, version 2.0. 
The USB specification is available from the USB Implementers Forum (USB-IF) at: 

Decoding Class Requests
Examples of a class request are Mass-Strg Class UFI CBI Requests, 
PTP Still Image Class Requests, Video Class Requests, and Wire Adapter Class 
Requests. 

To decode a class request: 

• From the USB Device Request menu, select Decode ... Request to display 
the View Fields for ... Class Requests text box.

The following figure shows a Wire Adapter Class Requests decoding:

Decoding Vendor Requests
To decode a vendor request: 

• From the USB Device Request menu, select Decode ... Request to display 
the View Fields for ... Vendor Requests text box.

An example of a vendor request is USB Advisor™ Command Set. 

Decoding Undefined USB/WUSB Device Requests
A Decoding Request may not belong to any of the defined decoding groups (Standard, 
Class, or Vendor).

USB Implementers Forum 
1730 SW Skyline Blvd.  
Suite 203 
Portland, OR 97221

Tel: +1/503.296.9892 
Fax: +1/503.297.1090 
Web: http://www.usb.org/
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Decoding using Endpoint Information
To decode using the endpoint information: 

Step 1 Left-click the Bulk/Int Transfer field to display the Bulk/Int Transfer (IN/OUT 
transaction with data) menu.

Step 2 Select Decode as ... Endp to open a View Fields for ... Endp text box.

The following figure shows a Wire Adapter Data Transfer Out Endp decoding: 

Changing the Layout of Decode Requests
In the View ... Fields windows, the Decoding Information and the Descriptor information 
blocks (following the Request Summary information) have the following columns:

• Field: such as bRequest, wValue, wIndex, bLength, bDescriptorType, 
wTotalLength

• Length in bits
• Offset in bits
• Decoded: hex value typically equal to Hex Value
• Hex Value: hex value typically equal to Decoded
• Description: short description of field
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To change the layout of decode requests display: 

Step 1 Click Layout to display the View ... Fields Dialog Layout dialog box: 

Figure 9.1 View WUSB Xfer Fields Dialog Layout Dialog Box

Step 2 To display the available columns of data, use the checkboxes for Length, Offset, 
Decoded, Hex Value, and Description.

You can Check All or Uncheck All.

Step 3 To show only the fields of Collapsed mode, check Show only fields specified 
for view in collapsed mode.

Step 4 To retain settings for future viewing of Decode Request fields, check Use these 
settings when View Fields dialog opens.
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Chapter 10:  Reports
The Report menu provides several reports to assist you in analyzing USB traffic recorded 
by the Analyzer. 
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10.1 File Information
To display a File Information report: 

• Select File Information under Report in the Menu Bar.
OR

• Click  in the Tool Bar to display the File Information screen: 

The File Information report provides information about how the recording was made, 
what the buffer settings were, the license number of the Analyzer that created the file, 
what the trigger options were, the user’s license information, and what version of all the 
Analyzer hardware was used to make the recording.
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10.2 Error Summary
The Error Summary details all errors analyzed throughout the recording.

• Select Error Summary under Report in the Menu Bar
OR

• Click  in the Tool Bar to display the Errors pane: 

Navigate to an error within the recording by clicking the number of the packet containing 
the error.

Use the arrows to cycle though each occurrence of a particular error.
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10.3 Timing Calculations
The Timing Calculator is used to measure timing between any two packets.

• Select Timing Calculations under Report in the Menu Bar.
OR

• Click  in the Tool Bar to display the Timing and Bus Usage Calculator 
screen: 
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10.4 Traffic Summary
Traffic Summary summarizes the numbers and types of packets, transactions, and so 
on that occurred in the open trace.

To run Traffic Summary, select Report > Traffic Summary,
or click the button marked . The program prompts you to specify a range of packets, 
then displays the following window: 
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10.5 Bus Utilization
The Bus Utilization window displays information on bandwidth use for the two recording 
channels. 

To open the Bus Utilization window, select Report > Bus Utilization
or click the  button to display three graphs: 
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of the displayed 
data and for exporting data:

The buttons have the following functions: 

Save As - Saves the graphs as a 
bitmap file (*.bmp) Vertical zoom in

Email - Creates an email with a 
*.bmp file attachment of the graphs Vertical zoom out

Print
Click and Drag zoom - Click 
diagonally to select and zoom in on 
part of the graph

Full Screen Select Range

View Settings - opens a sub-menu 
with options for formatting the 
display. See “Click the View Settings 
button  to open a menu with options 
for formatting the display:” below.

Sync and Graph areas - If two or 
more graphs are displayed, this 
button synchronizes the graphs to 
one another. Once synchronized, the 
positioning slider of one graph 
moves the other graphs.

Horizontal zoom in
Graph Areas - Presents options for 
displaying additional graphs of data 
lengths, packet lengths, and 
percentage of bus utilized.

Horizontal zoom out
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View Settings Menu
Click the View Settings button  to open a menu with options for formatting the 
display: 

• Orient Horizontally: Changes the orientation of bus usage to horizontal. 
After selecting this option, the menu option changes to Orient Vertically.

• Tile Vertically: Tiles the graphs vertically (i.e., side by side). After selecting 
this option, the menu option changes to Tile Horizontally.

• Show Markers: Places tick marks along the x axis of each graph.
• Show Plumb Line: Displays a vertical line that connects the cursor to the 

horizontal axis. As you move the mouse, the status bar shows the packet and 
time frame to which the cursor points.

• Status: Opens a submenu with the following options: 
• Bar: Displays a status bar at the bottom.
• Tooltip: Displays a tooltip if you position the cursor over a field of the 

graphs.
• None: Turns off tooltips and the status bar.

• Grid Lines: Opens a submenu with the following options: 
• Both: Displays both X and Y axis gridlines.
• X Axis: Displays X axis gridlines.
• Y Axis: Display Y axis gridlines.
• None: Turns off gridlines.

• Grid on Top: Moves the grid lines above the graph.
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• Fonts and Colors: Opens the View Options dialog box for setting graph fonts 
and colors: 
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Graph Areas Menu
Use the Graph Areas menu to specify information for the Bus Utilization window. 

Step 1 Click the  button to open the Graph Areas menu. 

Step 2 Select the data you want to appear in the Graph Areas window. 

Step 3 To make a new graph, click New.

To change properties in the Bus Utilizations graph: 

Step 1 In the Graph Areas menu, select what you want your graph to display, then click 
OK. 

Step 2 To make a new graph, click New.
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Chapter 11:  Recording Options
Use Recording Options to create and change various features that control the way 
information is recorded by the LeCroy USB Advisor™ Analyzer. 

To open the Recording Options menu: 

• Select Recording Options under Setup on the Menu Bar
OR

• Click  on the Tool Bar to display the Recording Options window at the 
General tab: 
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11.1 General Recording Options
The General Recording Options allow you to select or adjust the recording type, the 
buffer size, the amount of post-trigger recording, and the trace filename and path.

Recording Type
The Recording Type box presents three options that allow you to set how Advisor begins 
and ends a recording. 

The options are: Snapshot, Manual Trigger, and Event Trigger.

Snapshot
A Snapshot is a fixed-length recording whose size is determined by the Buffer Size box 
in the Recording Options dialog or 

by a manual click of the Stop button. Recording begins when  is clicked 

and ends when either the selected buffer size is filled or the  button is pressed. 

Manual Trigger
A Manual Trigger is a recording whose trigger point is caused by pressing the trigger 
button on the front panel.

Recording begins when you click  on the Tool Bar. Recording continues in a circular 
manner within the limits set by the buffer size.

Recording ends when  is clicked on the Tool Bar or after post-trigger memory has 
been filled following depression of the trigger button on the front panel.

Event Trigger
Recording begins when you click  on the Tool Bar.

Recording continues in a circular manner within the limits set by the buffer size until an 
event is detected that meets the Trigger conditions specified in the Triggering Options 
and the defined amount of data has been recorded after the Trigger Event.
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Options
Truncate Data Fields allows data fields to be truncated during recording to save 
Analyzer memory and allow recording of more packets. Enter a maximum data length 
value in the Bytes box. Advisor truncates the data to the stated value or slightly larger.

Note:  Truncation of data may cause incorrect transaction or transfer decoding. 

Beep When Trigger Occurs makes the computer connected to the Advisor beep three 
times when a Trigger condition is first detected.

Auto-Merge 2 Channel Trace Files causes Advisor to merge traffic of two recording 
channels into a file called data_merged.usb (or whatever name you wish to give it). 
Advisor also makes two other files during this recording: data.usb and data_classic.usb 
(or whatever names you choose to give them). If unchecked, Advisor create only two 
files: one for Classic-Speed traffic and another for Hi-Speed traffic.

Save External Interface Signals causes Advisor to save signals from a Breakout Board 
(pins TRIG IN - G.P. IN) as fields in the trace. 

Trigger/Filter Channel allows you to choose between Hi-Speed or Classic Speed. The 
selected choice tells Advisor what channel it should use to perform its triggers/filters. The 
last channel selected here is the one to be used for Triggering/Filtering. 

Buffer Size
You can adjust the size of the recording buffer from 0.1 megabytes to 128 megabytes.

The Recording Type option determines how this buffer is used. Although there are 128 
megabytes of physical memory in the Analyzer, the efficiency of the recording is about a 
2:1 ratio of physical memory to actual USB traffic. Shorter USB packets yield a slightly 
less efficient recording. The non-traffic portion of physical memory is utilized for control 
and timing information.

Note:  The scale is not linear and affords more granularity in the smaller buffer 
sizes. 

Trigger Position
You can adjust the amount of recording to be done post-Trigger or select where you want 
the Trigger located within the defined buffer. You can adjust the Triggering Position 
between 1 and 99% post-Trigger. Trigger Position is available only when Manual 
Trigger or Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position 
settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 
• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note:  When a Trigger occurs, recording continues until the post-Trigger amount of 
the buffer is filled or when Stop is selected.
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Options Name
The Options Name is a descriptive label of the current Recording Options settings. 
Options Names are associated with files that have a .rec suffix. 

The default option name is default. Default preserves the current Recording Options 
settings.

The purpose of the Options Name box is to give you a place to preserve different 
Recording Options that you use on a recurrent basis. For example, if you use two or three 
different Recording Options configurations, you can save these configurations and load 
them the next time they are needed.

Because Options Names are descriptive labels and not file names, you can enter in any 
text you like into the box. Your labels can be very descriptive such as "Trigger on High 
Speed traffic when CRC errors occur." 

To create a new Recording Options name: 

Step 1 Enter a comment for the new file in the Options Name field.

Step 2 Click Save to display the Save As window.

Step 3 Specify a filename (*.rec)

Step 4 Click Save.

To load a Recording Options name: 

Step 1 Click Load to display the Open window.

Step 2 From the list of .rec files, select the one that represents your Options Name to 
display the options settings for that name.

Trace File Name & Path
Trace File Name & Path opens a Save As dialog box for saving your trace file. The 
default recording file name is data.usb for Low, Full, and High Speed recordings. If you 
are recording on both channels, then Advisor creates two files: data.usb for Classic 
Channel, and data_classic.usb for High-Speed Channel.

• Click Trace File Name & Path to display a Save As… window in which to 
enter the recording file name *.usb for all subsequent recordings.
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11.2 Events Recording Options
The Event triggering and filtering options allow you to set specific parameters for each 
Event Group. When an Event Group is selected, a field appears that allows you to select 
specific conditions within the corresponding Event Group. As details are selected, other 
Event Group details may become "grayed out" because of limited hardware resources in 
the Analyzer. Information about the resources available is displayed below the Event 
Group details. When a detail is grayed out, it is inactive and cannot be selected. If an 
Event Group remains inactive, the current version of the application or BusEngine™ does 
not support it.

• Click the Events tab on the Recording Options screen to display the Event 
Groups window: 
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Packet Identifiers
• Select Packet Identifiers under Event Groups to display the Packet 

Identifiers window: 

The Packet Identifier (PID) field lists the available packet types. Select up to three packet 
types to use as a Recording Trigger. 

Token Patterns
• Select Token Patterns under Event Groups to display the Token Patterns 

window:

Specify up to three combinations of Address/Endpoint with any of the token PIDs. They 
can be triggered on or filtered in/out. 
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Frame Patterns
• Select Frame Patterns under Event Groups to display the Frame Patterns 

window: 

Identify frame patterns you want either to filter out of a Trace View or to use as a Trigger. 
You can select either All Start of Frame packets (SOF) to be filtered out or specify the 
Frame Number of a frame to trigger on.

Device Requests
• Select Device Requests under Event Groups to display the Device 

Requests window: 

You can select one or two Device Requests for triggering or filtering.
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Data Pattern
Step 1 Select Data Pattern under Event Groups to display the Data Pattern window: 

Enter a Data Pattern to be triggered upon or click Edit to open a pattern editor 
and enter data on a bit-by-bit basis.

Step 2 Press the Edit button to display a Bit-by-Bit window: 

Step 3 Click the bits within each byte that you wish to edit and enter appropriate text. 
The Mask and Match fields change.
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Bus Conditions
• Select Bus Conditions under Event Groups to display the Bus Conditions 

window: 

Use any combination of the listed errors as a Trigger.
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Errors
• Select Errors under Event Groups to display the Errors window: 

Use any combination of the listed errors as a Trigger.

• Bit Stuffing, Frame-Length, CRC, Pid, EOP Checkboxes: Select one or 
more of these errors to set these as the basis for triggering or filtering.

• Time-out Violation: Select this checkbox and then enter in the Turn-around 
time in the text box. This value tells the Analyzer how much time should 
elapse before triggering/filtering. Clocks are 60 MHz (with a resolution of 
16.66 ns).

• Excessive Empty Frame Detection: Select this option and enter the empty 
frame count in the text box. This value tells the Analyzer how many frames 
should elapse before triggering/filtering. 

• Babble Start Violation: Select this checkbox to trigger or filter whenever the 
start of a packet occurs too late in a Frame.

• Babble End Violation (or LOA): Select this to trigger/filter when the end of a 
packet occurs too late in a Frame. Enter a value in the EOF offset box from 1 
to 65,535 clocks to indicate the size of the offset from start of previous SOF.

• Bad Data Toggle: Select this checkbox to trigger or filter whenever a Data0, 
Data1, Data2 toggle violation occurs. 

• Select IN or OUT if you only want triggering/filtering to occur only on IN 
or OUT transactions. 

• Check Incl. Reset if you want the first toggle value after a reset to be 
considered “good” regardless of the value prior to that reset. If 
Unchecked, toggle state is assumed to be preserved through the reset. 

• Select Addr and/or Endp to select Token Addresses and/or Endpoints.
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External Input Signals
• Select External Input Signals under Event Groups to display the External 

Input Signals window:

This window has two checkboxes: Input 1 (TRIG IN) and Input 2 (G.P. IN). Use any 
combination of the inputs as a Trigger.

Transactions
• Select Transactions under Event Groups to display the Transactions 

window: 

Use any combination of the listed errors as a Trigger.
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Data Length
• Select Data Length under Event Groups to display the Data Length 

window: 

To trigger on data length, enter a value between 0 and 1024 in the box marked Data 
Length. 

Splits
• Select Splits under Event Groups to display the following window. 

Selecting Splits allows you to trigger on the attributes of a Split Packet. 
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11.3 Actions Recording Options
The Actions screen serves as a means of setting Triggers, Filters (In or Out), and 
Counts for the events selected in the Events window.

Actions Window Layout
The Actions window displays buttons for the events selected in the Events window. 
Events buttons tell Advisor what it should look for during a recording. The number of 
Event buttons displayed depends on the number of Events selected in the Events 
window. If no Events are selected, no Event buttons are displayed.

The upper right corner of the window displays a pair of counters called Count1 and 
Count2. Counters provide a way for setting triggers based on a passage of a certain 
number of events. When an event is linked to a counter, the counter attaches below that 
event. In the following example, Advisor is set to trigger following an In Packet Identifier, 
then a 25 counts of a token or an In Packet Identifier, then a Token, then an Error. 

The lower right corner displays the Trigger, Filter Out, and Restart buttons. Action 

buttons controls the Advisor response to Event conditions. For example, if an Error button 
is linked to a Trigger button, the Action button tells Advisor to trigger when the error 
condition occurs.

The lines that join the different buttons indicate the links between Actions and Events. 
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11.4 Connecting Events to Actions
To create or edit links between Event buttons, Counters, and Action buttons, you click an 
Event button and then click a Counter or Action. By clicking an Event, an arrow connects 
the Event button to the cursor. When you click a Counter or Action button, the arrow 
becomes anchored to the selected button.

To make an association: 

Step 1 Select one or more Events from the Events window.

Step 2 Open the Actions window.

Step 3 Click the left mouse button on an Event button such as Errors.

The elastic arrow appears.

Step 4 Point the mouse at the desired Action button.

The elastic arrow moves with the mouse pointer.

Step 5 With the pointer over an Actions button, click the left mouse button again.

The arrow is anchored to the Action button and replaced with a black line 
connecting the Event button to the Action button.
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11.5 Connecting Counters to Events
The center section of the Actions window displays two Counter buttons marked Count1 
and Count2. 

Counters provide a way of triggering after a number of events have passed, such as 
"Trigger after the 20th IN packet." 

Counters have blue dots in their top left corner that provide access to pop-up menus. The 
menus provide the means of setting the counter value. The counter can be set between 
1 and 65,535. 

To connect an event to a counter: 

Step 1 Open the Event window and select an Event.

Selecting an Event causes an Event button to automatically appear in the 
Actions window. 

Step 2 Open the Actions window.

The window displays an Event button that is connected to the Trigger button on 
the right via a line.

Step 3 Click the Event button. 

An arrow appears that connects the Event button to your mouse pointer. 

Step 4 Click one of the two counters.

The Event automatically connects to the Counter button and then connects to the 
Trigger button. 



Chapter 11: Recording Options USBAdvisor User Manual

128 LeCroy Corporation

Step 5 Click the blue dot in top left corner of the selected counter to display a pop-up 
menu that allows you to configure the counter.

Step 6 Choose Change Counter Value to open a dialog box.

Step 7 Set the counter to a value, then click OK.

The Input Counter Value dialog box closes and the Counter button displays the 
selection.

Setting Multiple Conditions with Counters
You can create multiple event conditions by linking two counters to two or more events.

Linking Two Events to Two or More Counters - If an Event is linked to Count1 and a 
second event is linked to Count2, it creates an OR statement. This statement reads 
"Trigger when Count1 OR Count2 has reached their specified values."

In this example, Advisor is set to trigger following an In Packet Identifier, then 25 counts 
of a token or an In Packet Identifier, then a Token, then an Error.
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11.6 Using Action Buttons
The right section of the Actions window displays three Action buttons labeled Trigger, 
Filter Out/In, and Restart. 

Trigger
The Trigger button enables event triggering. 

Restart
Restart causes counters to restart counting when a certain event occurs. When Restart 
is used, the screen has at least two links: one between an Event and the Restart button, 
and a second between an Event, Counter and an Action button.

The screenshot below gives an example. The screen below reads "Look for IN and Out 
packets. When 10 OUT packets, trigger. However, if an IN packet occurs during the 
count, restart the count."
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Filter Out/In
The Filter In/Out button causes events to be filtered in or out of the recording. Filter 
Out/In toggles between Filter Out and Filter In.

• Filter In records ONLY those packets related to the specified event.
• Filter Out records all packets EXCEPT those related to the specified event.

Note:  Only events from the Token, Frame Event, Device Request, and Transaction 
Groups can be used to filter a recording.

To filter in or out Token, Frame Event, Device Request, and/or Transaction Group events 
from a recording: 

Step 1 Click the blue dot on Filter Out (may say Filter In depending on the last action 
specified) to display the Filter Polarity menu: 

Toggle the selection between Filter Out and Filter In.

Step 2 Select Filter In. 

The button changes to read Filter In.
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11.7 Other Actions: External Output Signals
Most Event buttons can be configured to trigger external output signals.

If a blue dot is present in the Event button, it means that a menu is present with three 
options for configuring external output signalling:

• Enable External General Purpose Output
• Enable External General Purpose Output only
• External Output Form 

If you choose to enable External Output signalling, a small blue arrow  projects from 
the Event button. This arrow is a reminder that External Signals have been set.

To enable or disable external trigger output: 

Step 1 Click the blue dot on an Event button.

A menu similar to the one below opens. The menu may say Disable instead of 
Enable.

Step 2 Select Enable External Trigger Output or Disable External Trigger Output.
If you select Enable External Trigger Output, a small arrow appears on the 
right side of the button to indicate that a condition has been set for creating an 
external output signal.

Choosing Disable External Trigger causes the arrow to disappear.
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Enabling High Pulse, Low Pulse or Pulse Toggle Signal Outputs
If you chose External Trigger Output in the previous steps, an additional choice 
appears in the Blue Dot menu, Enable External Trigger, that lets you control the output 
signal.

Step 1 Click the blue dot on an event button that has a small arrow attached to it like the 
one shown above.

A Blue Dot menu opens. External Trigger Form should be an option. If it is not, 
choose Enable External Trigger and then reopen the menu.

Step 2 Choose External Trigger Form to display a menu with choices for Pulse Low, 
Pulse High, and Toggle. 

Step 3 Choose an option not currently selected to close the menu.

Step 4 Reopen the menu.

Note that the new selection is now checked.
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11.8 Saving Recording Options
To complete your Recording Options settings, use the features at the bottom of the 
Recording Options screen. These features remain the same no matter which of the 
three Recording Options screens you are working in.

• Click Save to save the currently specified Recording Options for use in future 
recording sessions. Any file name can be specified, though use of the .rec is 
recommended; if no extension is specified, .rec is added by default.

• Click Load to load a previously saved *.rec file, thus restoring a previous set 
of Recording Options.

• The Save as Default function is equivalent to the Save function, specifying 
the file name default.rec. Whenever you start up the Analyzer, it 
automatically loads the default.rec file if one exists.

• Click OK to apply any changes and close this dialog box.
• Click Cancel to cancel any immediate changes you have made and exit the 

Recording Options menu.
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11.9 Recording Bus Data
Note: If you have inserted any event triggers, be sure to select Event Trigger under the 
General tab in the Recording Options dialog box. 

To start recording USB traffic after setting the appropriate Recording Options: 

Step 1 Select Start under Record on the Menu Bar.
OR

Click  on the Tool Bar.

Your recording session can continue until it has finished naturally or 

you may need to stop manually by clicking  on the Tool Bar, depending on how you 
set the Recording Options.

To manually stop recording: 

Step 2 Select Stop under Record on the Menu Bar.

OR

Click  on the Tool Bar.

Note:  The manual Stop Recording feature is primarily of use when recording 
low-speed traffic, which can take a long time to fill the recording buffer.

While uploading is still in progress, hitting the stop button opens a dialog that contains 
the following options:

• Partial Upload (loads only a portion of the trace)
• Flush current file
• Keep only what was uploaded so far
• Continue uploading

When the recording session is finished, the bus traffic is saved to the hard drive as a file 
named data.usb or whatever name you assign as the default filename. 

To save a current recording for future reference: 

Step 3 Select Save As under File on the Menu Bar.

OR

Click  on the Tool Bar.

You see the standard Save As screen.

Step 4 Give the recording a unique name and save it to the appropriate directory.
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11.10 Merging Trace Files
It is possible to merge a Classic-Speed trace file with a Hi-Speed trace file using the 
Merge Trace File command under the File menu. This option only works with files that 
were created simultaneously through a single recording session. If the files were 
recorded during separate recording sessions, Advisor generates an error message and 
prevents the merge from completing.

Note:  Advisor is capable of merging High Speed and Classic Speeds traffic into a 
single merged file if the Auto-Merge 2 Channel Trace Files option is 
checked in the Recording Options dialog box. See page 115 for details.

To merge two trace files: 

Step 1 Select File > Merge Trace Files to open a dialog box asking for the first source 
file. 

Note:  The Merge Trace Files command can be run with or without a trace file open 
on the screen. The merge process ignores the open file.

Step 2 Select the first trace file to be merged, then click Save.

Note:  It does not matter which of the two trace files is first selected, as long as both 
were recorded in the same session.
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Step 3 Select the second trace file to be merged, then click Save.

Step 4 Click Yes to confirm your choices.

The two files are merged into the new file data_merged.usb.

Note:  If you attempt to merge two files that were recorded in separate recording 
sessions, the following error message appears: 
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Chapter 12:  Updates
From time to time as modifications are made to the Advisor Analyzer, it is necessary to 
update the Advisor for optimal performance. Updates can be performed two ways: either 
automatically or manually. This chapter describes both procedures.

12.1 Software, Firmware, and BusEngine Revisions
The Readme.txt file on the installation CD and in the installed directory gives last-minute 
updates about the current release. Included with each release are the most recent 
downloadable images of the Firmware and the BusEngine™. 

Once the Analyzer has completed the self-diagnostics and is connected to the PC, you 
can check the latest revision of the software and BusEngine by selecting About 
Advisor… from the Help menu.:

About USB Advisor details revisions of the following software and hardware: 

• Advisor Software Version
• Advisor Firmware Version
• BusEngine Version
• Unit Serial Number

Note:  When contacting LeCroy for technical support, please have available all the 
revisions reported in the About USB Advisor window.
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12.2 Software Updates
When a new software release is available, it is posted on the Support page of the LeCroy 
website at www.lecroy.com/support.html.
To update the software: 

Step 1 In the About Advisor screen, verify which version of LeCroy USB Advisor™ 
Software you are currently running.

Step 2 Find the latest released software version on the LeCroy website under Support.
If you are running the latest version of the software, no further action is needed. 

If you are not running the latest version, continue to Step 3.

Step 3 Download the Zip files from the website. 

Step 4 Unzip the files into your choice of directory.

Step 5 Click Start, then Run, and browse to where you unzipped the files.

Step 6 Select the program named Setup and click Open.

Step 7 Click OK to run the Setup and begin the installation.

Step 8 Follow the on-screen instructions to complete the installation.

Step 9 Read the Readme.txt file for important information on changes in the release.
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12.3 BusEngine and Firmware Updates
BusEngine and Firmware updates often need to be performed when you update the 
Advisor software. These updates can be performed automatically or manually. Both 
processes are described.

Updating the Firmware
Within a new software release, it may also be necessary to update the Analyzer’s 
firmware for proper operation. The Readme file informs you if this is necessary. 

Automatic Updates
When the Advisor software is updated, the software may become incompatible with the 
BusEngine and Firmware. If a recording is attempted, Advisor displays an error message 
and then automatically begins an update process for the BusEngine and Firmware. 

To perform an automatic BusEngine and Firmware update, follow these steps:

Step 1 If needed, update the Advisor software using the steps outlined in “Software 
Updates” on page 138.

Step 2 Turn on the Analyzer.

Step 3 On the Tool Bar, click the  button.

Since the BusEngine and/or the Firmware are incompatible with the current 
Advisor software version, an error message appears displaying your current 
versions and indicating what versions you need to install.

Step 4 Click Yes to close the window closes and open the Analyzer Setup window. 



Chapter 12: Updates USBAdvisor User Manual

140 LeCroy Corporation

Step 5 Click Update BusEngine or Update Firmware on the Analyzer Setup screen.

You can select only one item at this point. If both the BusEngine and the 
Firmware need to be updated, the update completes the first item and then 
returns to the above screen so the second update can be performed. 

If you are running Power cycle Advisor to complete the update.

If you are running Microsoft® Windows® 2000, the Analyzer automatically 
reboots and causes the following message to appear.  Note: Support for 
Windows 2000 will end on January 1, 2008. When this message appears, click 
OK. You do not need to power cycle the Analyzer.
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Manual Updates to BusEngine and Firmware
You can manually update the Advisor Firmware and/or BusEngine by completing the 
following steps:

Step 1 Select Analyzer under Setup on the Menu Bar to display the Analyzer Setup 
screen: 

Step 2 To update the BusEngine, click Update BusEngine on the Analyzer Setup 
screen to display the Select engine file to download window: 

The program displays the correct file (Advbe.rbf) in the File name field. This file 
is used to update the Analyzer alone.

Note:  The most current Primary BusEngine file was copied to your 
\LeCroy\Advisor directory when you installed the program. 

Step 3 Click Open.

Step 4 Power cycle the Analyzer.

Re-initialization takes a couple of minutes.
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Manually Upgrading the Firmware
To update the firmware: 

Step 1 Click Update Firmware on the Analyzer Setup screen to display the Select 
firmware file to download window: 

The program has already automatically searched for the correct file and displays 
it in the File name field.

Step 2 Click Open.

The Analyzer updates the Firmware.

Step 3 Unplug the USB cable from the back of the Analyzer box and then reinsert it so 
the new Firmware update can take effect.

Resetting the Analyzer
Clicking the Reset Analyzer button is equivalent to power cycling the Advisor Analyzer.
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Appendix A:  Legacy Script Decoding
Earlier LeCroy USB Analyzers used .REQ and .DSC script files to decode class and 
vendor requests. 

• .REQ stands for Requests.
• .DSC stands for Descriptors.

This method uses fixed definitional structures. 

For legacy script decoding, LeCroy provides .req files for the following requests and 
classes:

• Standard Requests (standard.req)
• Hub Class (hub.req)
• HID Class (hid.req)
• Printer Class (printer.req)
• Communications Class (communication.req)
• Audio Class (audio.req)
• Bluetooth USB HCI commands and events (bluetooth.req)
• Vendor Request definition file (vendor.req)

Note:  .req files are no longer used in LeCroy USB Analyzers.  
In addition, .req files are not compatible with the UWBTracer 
application. 
The new script decoding for LeCroy USB Analyzers uses 
Script Decoder version .dec files. 
.dec files are compatible with the UWBTracer application. 
It is highly recommended that you use the new Script Decoder 
mechanism.  
For information about .dec files and the new script decoding, see 
“Class and Vendor Definition Files” on page 85.

If you must add your own .req file for a Class or Vendor Request, do the following: 

Step 1 Use the Notepad application to create and edit your own Request Definition file 
(for example, my_vendor_commands.req).

Note:  To learn to write such a file, review the Request (.req) files provided by 
LeCroy.

Step 2 Add the name of your Request file to the request.lst file.

Step 3 Click Setup. The decoding menu in the Class/Vendor List appears.
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Appendix B:  China Restriction of Haz-
ardous Substances Table

The following tables are supplied in compliance with China's Restriction of Hazardous 
Substances (China RoHS) requirements: 
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized representative ("you" or "your"), 
fully complete and return the registration card provided with the 
applicable hardware product or peripheral hardware products 
(each a "Product") within fifteen days of the date of receipt from 
LeCroy or one of its authorized representatives, LeCroy warrants 
that the Product will be free from defects in materials and workmanship for a period of three years 
(the "Warranty Period"). You may also complete your registration form via the internet by visiting 
http://www.catc.com/support/register/. The Warranty Period commences on the earlier of the date 
of delivery by LeCroy of a Product to a common carrier for shipment to you or to LeCroy's 
authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover
This warranty does not cover damage due to external causes including accident, damage during 
shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems with electrical 
power, including power surges and outages, servicing not authorized by LeCroy, usage or 
operation not in accordance with Product instructions, failure to perform required preventive 
maintenance, software related problems (whether or not provided by LeCroy), problems caused by 
use of accessories, parts or components not supplied by LeCroy, Products that have been modified 
or altered by someone other than LeCroy, Products with missing or altered service tags or serial 
numbers, and Products for which LeCroy has not received payment in full.

Coverage During Warranty Period
During the Warranty Period, LeCroy or its authorized representatives will repair or replace 
Products, at LeCroy's sole discretion, covered under this limited warranty that are returned directly 
to LeCroy's facility or through LeCroy's authorized representatives.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy 

Customer Support 
3385 Scott Blvd. 
Santa Clara, CA 95054

Send e-mail… support@catc.com
Visit LeCroy’s web site… http://www.lecroy.com/
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How to Obtain Warranty Service

To request warranty service, you must complete and return the registration card or register via the 
internet within the fifteen day period described above and report your covered warranty claim by 
contacting LeCroy Technical Support or its authorized representative. 

You can reach LeCroy Technical Support at 800-909-7112 or via email at support@catc.com. You 
may also refer to the LeCroy website at http://www.lecroy.com for more information on how to 
contact an authorized representative in your region. If warranty service is required, LeCroy or its 
authorized representative will issue a Return Material Authorization Number. You must ship the 
Product back to LeCroy or its authorized representative, in its original or equivalent packaging, 
prepay shipping charges, and insure the shipment or accept the risk of loss or damage during 
shipment. LeCroy must receive the Product prior to expiration of the Warranty Period for the 
repair(s) to be covered. LeCroy or its authorized representative will thereafter ship the repaired or 
replacement Product to you freight prepaid by LeCroy if you are located in the continental United 
States. Shipments made outside the continental United States will be sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. LeCroy does not 
accept liability for lost or damaged peripheral accessories, data or software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or reconditioned 
parts, at its sole discretion, made by various manufacturers in performing warranty repairs. If 
LeCroy repairs or replaces a Product, the Warranty Period for the Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product returned or that the 
returned Product is not eligible for warranty coverage, LeCroy will inform you of its determination. 
If you thereafter request LeCroy to repair the Product, such labor and service shall be performed 
under the terms and conditions of LeCroy's then current repair policy. If you chose not to have the 
Product repaired by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and 
that LeCroy may require payment in advance of shipment.
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General Provisions

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE 
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. LECROY'S RESPONSIBILITY FOR 
DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT 
AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS EXPRESSLY 
STATED IN THIS WARRANTY STATEMENT, LECROY DISCLAIMS ALL EXPRESS AND 
IMPLIED WARRANTIES FOR ANY PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE 
OF DEALING, COURSE OF PERFORMANCE OR TRADE USAGE. SOME JURISDICTIONS MAY 
NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE 
PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN THIS 
LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES 
INCLUDING, WITHOUT LIMITATION, ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST 
YOU FOR DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA 
OR SOFTWARE. LECROY'S LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID 
FOR THE PRODUCT THAT IS THE SUBJECT OF A CLAIM. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THE PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the then current 
owner transfers ownership of the Product and notifies LeCroy of the transfer. You may notify 
LeCroy of the transfer by writing to Technical Support at LeCroy, 3385 Scott Blvd., Santa Clara, CA 
95054 USA or by email at: support@catc.com. Please include the transferring owner's name and 
address, the name and address of the new owner, the date of transfer, and the Product serial 
number.
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Index

Symbols
.dec files 85
.dsc files 143
.rec files 116, 133
.req files 143
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2-stage SOF Hiding option 76
5-volt pin 12

A
abort upload 35
About Advisor

command 15
window 15

About Advisor command 137
About USB Advisor window 137
Abstract Control Model .dec file 85
AC connector module 10
AC power source 23
actions

buttons 129
events 126
Recording Options 125

Actions window 125
Add New Hardware Wizard window 15
Addr & Endp search 70
Addr checkbox 122
Addr field 89
Advbe.rbf file 141
Advisor.inf file 15
alert

beep 115
Allow any Toggle value after Bus Reset option 76
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command 141
front panel 9
PC requirements 8
rear panel 9
resetting 142
setup 21
Setup screen 141

architecture 21
arrow

elastic 126
ATM Networking Control Model .dec file 85
Audio Class .dec file 85
Audio Class decoding 2.0 85
audio.req file 143
automatic updates 139
Auto-merge 2 Channel Trace Files option 115

B
Babble End Violation error 122
Babble Start Violation error 122
Bad Data Toggle error 122
Beep When Trigger Occurs option 115
Bit Order option 48
Bit Order section 81
Bit Stuffing error 122
Bit-by-Bit window 120
bits

raw 44
blue dot 128

menus 130
bluetooth.req file 143
Breakout Board 8, 12
browser 8
BT .dec file 88
buffer size 2
Buffer Size dialog 115
Bulk transfer 54
Bulk/Int Transfer field 91
bus

usage 77
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Bus Conditions event group 121
Bus Conditions search 71
Bus Conditions shortcuts 39
bus data

recording 134
Bus Utilization

buttons 109
report 108
window 109

Bus Utilization option 77
BusEngine

updates 137
BusEngine Technology 6
buttons

actions in recording options 129
bus utilization 109
Detach Device 9
Filter In/Out 130
Manual Trigger 9
restart 129
toolbars 33
Trigger 129

Bytes box 115
Bytes menu 69

C
Cable Based Association Framework .dec file 88
cables 8

connecting 15
connectors 12
length 23
USB 13

CAPI Control Model .dec file 85
CATC Trace 1, 7
Change Counter Value command 128
channel

trigger
and filter 115

Channel search 72
channels

recording 2
Chirps, hide 49
class definition files 85, 143
Class Request

decode 100
Class request, decode 100
Class/Vendor decoding 89
Class/Vendor Decoding field 89
Class/Vendor Decoding Groups menu 90

Class/Vendor Endpoint Decoding
field 91
menu 92

Class/Vendor endpoint RPipes decoding 95, 97
classes 143
Classic Speed port 9
Clear Marker command 43
Collapse All Data Fields command 47
collapse data fields 46
Collapse Data menu 47
Collapse This USB Transfer command 56
collapse transactions 53
collapse transfers 55
collapsed mode 76
color

display 8
Color section 79
Color/Format/Hiding tab 78
colors 79
Colors options 111
comment field 63
Comments attribute 63
comments, editing 63
Communication Device Subclass/EEM .dec file 85
communication.req file 143
Communications and CDC Control .dec file 85
Communications Device Class (CDC) Data 87
Communications Device Class (CDC) Data .dec file 
87
compatibility 12
components 8

physical 2
configuration 8
Configuration Name option 77
connecting

cables 15
connections 21

cable 12
connect events to actions 126
connector pin-out 13
counters to events 127
to a PC 13

connector
Data In/Out 22
DB-9 10

connectors 10, 11, 12
types 23

contents of package 8
Continue uploading command 134
Control Transfer 54, 98
Control Transfer field 98



USBAdvisor User Manual Index

LeCroy Corporation 153

convert.usb file 27
Counter buttons 127
counters 5, 125

connecting to events 127
events 127

counting 5
events 6

CRC error 122
Custom tab 80
Customize

command 32
dialog box 32

D
data

data length 69
data pattern 120
expand/collapse fields 46
truncate data fields 115
viewing data block 48

data block 48
Data Block dialog box 48
Data Field menu 48
data fields

truncate 115
Data In/Out connector 12, 22
Data Length event group 124
Data Length search 69
Data option 77
Data Pattern event group 120
data types 79
data.usb file 17, 35, 116, 134
data_classic.usb file 35, 116
data_merged.usb file 115, 136
date and time formats 80
DB-9 connector 22
Decode

decoding options 89

decode
class request 100
endpoint 91, 101
endpoint DWA RPipes 97
endpoint RPipes 95
general options for requests 98
hub status 101
layout 102
request recipient 89
Request rRPipe 94, 96
requests 98, 99
standard request 99
vendor requests 100

Decode ... Request command 100
Decode as ... Endp command 101
Decode Standard Request command 99
decoder files 85
decoding

assigning 89
decoded transactions 52
decoded transfers 55
decoding fields 56
refresh 98

default settings 17
default.opt file 83
default.rec file 116, 133
description

product 7
Detach Device button 9
Detach Device switch 2, 11
Device Management Model 85
Device Requests 98
Device Requests event group 119
Device Wire Adapter .dec file 88
Device Wire Adapter Segment View 58
Device Wire Adapter Transfer View 58
devices

hiding 49
diagnosis 23
dimensions 11
Direct Line Control Model .dec file 85
direction

search 36, 74
Direction field 91
directory

application 24
Disable External Trigger Output command 131
disk space 8
display 8

configuration name 77
trace 4
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Display Options 3
Color/Format/Hiding tab 78
colors 79
command 75
default values 77
formats 80
General tab 76
hiding fields in a trace 81
hiding whole packets 82
loading 83
saving 83
window 75

dot
blue 128

drivers
loading 24

DWA RPipes
endpoints 97

E
Edit Comment command 63
Edit comment for Trace file window 63
Edit Marker Comment

command 43
window 43

Edit Marker Comment window 42
editing

data pattern 120
edit comment 63
marker 43

elastic arrow 126
electrical source 23
Electrically Programmable Logic Device 6
e-mail 147
empty frame 122
Enable External Trigger command 132
Enable External Trigger Output command 131
Enable Tips option 76
Endp checkbox 122
Endp field 91
endpoint

decoding 91
Endpoint RPipes

dialog box 95, 97
tab 95, 97

Endpoints
tab 91

endpoints
decoding 101
DWA RPipes 97
RPipes 95

Endpoints dialog box 91
environment 11
EOF offset box 122
EOP error 122
Error Report option 77
Error Summary report 105
Errors

menu 69
search 69

errors
detection 5

Errors event group 122
Errors option 62
Errors pane 105
Errors section 77
Errors window 122
Esc button 35
Ethernet Networking Control Model .dec file 85
Event button

blue arrow 131
event groups 117
Event Groups window 117
Event Trigger recording type 114
events

actions 126
connecting to actions 126
counters 127
counting 6
filtering 117
groups 117
multiple 128
recording options 117
sequencing 6
trigger recording 114
triggering 117

Events tab 117
Excessive Empty Frame Detection error 122
Exclusion search 73, 74
Expand All Data Fields command 47
expand data fields 46
Expand Data menu 47
Expand Packet Data Fields by default option 76
Expand Script-Based Decoded Info by default op-
tion 76
expand transactions 53
Expand Transfer menu 55
expand transfers 55
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expanded mode 76
External Input Signals event group 123
External Interface Breakout Board 12
external interface connector 10
External Output Signals action 131
External Trigger Form 132

F
features

product 1
trace 19

Fields option 77
File Information report 104
File menu 28
File name field 142
files

.dec 85

.dsc 143

.opt 83

.rec 116, 133

.req 143

.usb 116
auto-merge 2 channel 115
file information report 104
File menu 28
merging trace files 135
script 85, 143
trace filename 116

Filter Out/In button 130
Filter Polarity menu 130
filtering 2, 5

events 117
Find command 73
Find Next command 74
firmware

updates 137, 139
Flush current file command 134
Fonts option 77
Fonts options 111
fonts, changing 77
Format option 48
Format section 81
formats

date 80
Display Options 80
number 80
text 80

Frame Patterns event group 119
Frame-Length error 122
Front Panel 9

fuse 10

G
General tab

Display Options 76
Recording Options 114

glass fuse 10
Go to

command 67
Marker command 66
menu 67
Packet/Transaction/Transfer command 66
Trigger command 65

Graph Areas menu 112
graphical display 4
green LED 9
Grid Lines options 110
Grid on Top option 110
ground pins 12
Group and Color column 79

H
hard disk space 8
hardware

setup 22
Help menu 31
HID .dec file 86
hid.req file 143
Hidden checkbox 81
Hide NAKs button 49
Hide SOF Packets button 49
hiding 4

Chirps 49
devices 49
fields in a trace 81
levels 82
NAKs 49
packets in a trace 82
SOF 76
SOF packets 49

Hierarchy Lines option 76
High Speed port 9
host

compatibility 12
computer requirements 8

Host field 89
Host Wire Adapter .dec file 88
Host Wire Adapter Segment View 57
Host Wire Adapter Transfer View 58
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hot keys 38
Hub .dec file 86
hub.req file 143
humidity 11
HUT .dec file 86
HWA address field 94

I
IN checkbox 122
Incl. Reset checkbox 122
initialization 23
Input Counter Value dialog box 128
Install Software command 15, 24
installation

basic 15
detailed 8
software 24

Interface Association Descriptor .dec file 88
Internet browser 8
Interrupt transfer 54
Intersection search 73, 74
Invalid Data field 80
Isochronous transfer 54

K
Keep Across Recordings checkbox 90
Keep only what was uploaded so far command 134
keyboard

shortcuts 38
keys

shortcuts 38

L
layout 102
Layout command 102
LED lights 9
LEDs 11
Legend 62
lengths

cables 23
letter 147
Level Hiding tab 82
lines

hierarchy 76
linking

events 128
LOA error 122
load

recording options 116

Load command 83, 116, 133
loading USB Drivers 24
logical objects 59

M
manual

updates 141
Manual Trigger button 9
Manual Trigger recording type 114
Manual Trigger switch 11
Map DWA RPipe to Class/Vendor Decoding com-
mand 96
Map Endpoint to Class/Vendor Decoding command 
91
markers 3

clearing 43
editing 43
setting 42
show 110

Mask field 120
Mass Storage .dec file 86
Match field 120
Media Transfer Protocol 59
memory 2

recording 11
menus

blue dots in events 130
graph areas 112
menu bar 28
pop-up 76
view settings 110

Merge Trace Files command 135
merging trace files 115, 135
Micro Frames 2
Microframes 41
miscellaneous shortcuts 39
Mobile Direct Line Model 85
mode

collapsed 76
expanded 76
Trace Viewer 27

Monitor .dec file 86
MTP 59
Multi-Channel Control Model .dec file 85
multiple event conditions 128
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N
NAKs, hiding 49
navigation 61, 77

tools 37
trace navigator 61

Navigation shortcuts 38
Navigator bar 61
Navigator option 77
No Decoding option 90
number formats 80

O
OBEX Model 85
object handles 59
object transfers 59
On-The-Go search 72
operating range 11
operating system 12, 24
opt files 83
Options Name field 116
Orient Horizontally option 110
Orient Vertically command 110
OTG shortcuts 39
OUT checkbox 122
output signals 131
overview 1

software 27

P
package contents 8
Packet # field 42
packet ID search 68
Packet Identifiers event group 118
Packet IDs

go to 68
Packet menu 42
packet too late 122
packets

display level 77
hiding 49, 82
identifiers 118
packet IDs (PIDs) 68
Packet/Transaction/Transfer 66
view features 19

Packing List 8
Partial Upload

button 36
dialog 36

Partial Upload command 134

patterns
token 118

percentage of pre/post triggering 115
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Physical .dec file 86
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Physical Interface .dec file 86
Picture Transfer Protocol 59
Picture Transfer Protocol .dec file 87
Pid error 122
PID shortcuts 38
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Plug and Play instructions 15
Point of Sale Devices .dec file 86
pop-up menus 76
popup tool tips 49
port 12
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position

trigger 115
powe
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power
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on/off switch 10
requirements 11
socket 10

Power .dec file 86
Power LED 11
Pre/Post Trigger option 62
Printer .dec file 86
printer.req file 143
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description 7
features 1

Progress Bar 35
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progress of recording 34
protocols
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PTP Object 59
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Q
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R
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viewing 44
Raw Bits View 44
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Recent Ranges option 62
Recipient field 89
Record function 35
Record menu 29
Recorded Data file 35
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Event Trigger 114
Manual Trigger 114
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progress 34
status 35
type 114
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Recording LED 11
recording LED 9

Recording Options 2
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command 113
creating 116
default settings 17
events 117
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load 116, 133
menu

 113
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saving 133
window 113

Recording Progress Indicator 34
Recording Type box 114
red bar 42
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refresh 98
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Report menu 29, 103
reports 103
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tab 96
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Request RPipes 94, 96

dialog box 94, 96
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request.lst file 143
requests 98, 143
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Reset All button 32
Reset Analyzer button 142
resetting
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toolbar 31
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Restart button 129
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rework area 13
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RPipe field 94, 96
RPipes 94, 96

endpoints 95
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files 88
Manual 88
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Scripts directory 85
SCSI/Bulk Protocol .dec file 86
search 65
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menu 65
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union 73

Search menu 29
Select engine file to download window 141
Select firmware file to download window 142
self-diagnosis 23
sequencing 6
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Set Marker command 42
Set range near Packet number option 62
Set Range to Whole Trace option 62
setting
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trigger conditions 126

settings
default 17

SETUP
field 98
transaction 98

Setup
program 138

setup
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system 21

Setup menu 28
shortcut keys 38
shortcuts 38
show
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Show Markers option 110
Show Per Line option 48
Show Plumb Line option 110
Show Raw Bits command 44
Show Stuff Bits checkbox 45
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signals

external input 123
output 131

Smart Card .dec file 87
Smart Card Class 87
Snapshot recording type 114
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SOF packets, hiding 49
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installation 24
overview 27
revisions 137
startup 25, 27
updates 138

specifications 11
speeds 1, 9
Split Transactions View 54
Splits event group 124
standard.req file 143
Start command 134
starting

software 25, 27
Start-of-Frame packets 49
status

recording 35
Status bar 34
Status options 110
Still Imaging Class .dec file 86
Stop command 134
Stop Recording feature 134
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support 147
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setup 21
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technical support 147
Telephone Control Model .dec file 85
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Time-out Violation error 122
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Timing and Bus Usage Calculator screen 106
Timing Calculations report 106
Timing Calculator option 77
Toggle option 132
toggle violation 76, 122
Token Patterns event group 118
toolbar

resetting 31
toolbars

buttons 33
tab 32

tooltips 27, 49, 76
trace

filename and path 116
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hiding packets 82
merging files 115, 135
navigator 61
reading 41
recording 16, 25
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Trace File Name & Path command 116
Trace Navigator 61
Trace View 41
Trace Viewer mode 27
Trace Viewing Level option 77
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recording 16
Traffic Summary option 77
Traffic Summary report 107
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Transactions event group 123
Transactions View 50
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trigger
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Truncate Data Fields option 115
Turn-around time 122
type A connector 23
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Universal Serial Bus Specification 100
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Update Firmware command 142
updates 137
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manual 141
software 138
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upload
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On-The-Go 72
port 15
recording traffic 16
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USB Implementers Forum 7, 100
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vendor definition files 85, 143
vendor.req file 143
versions 15, 137
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Wire Adapter Transfer 58, 59, 60
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View Settings

button 110
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Wire Adapter .dec file 88
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